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Notice

While reasonable efforts have been made to ensure that the
information in this document is complete and accurate at the time

of printing, Avaya assumes no liability for any errors. Avaya reserves
the right to make changes and corrections to the information in this
document without the obligation to notify any person or organization
of such changes.

Documentation disclaimer

“Documentation” means information published in varying media
which may include product information, subscription or service
descriptions, operating instructions and performance specifications
that are generally made available to users of products.
Documentation does not include marketing materials. Avaya shall
not be responsible for any modifications, additions, or deletions

to the original published version of Documentation unless such
modifications, additions, or deletions were performed by or on the
express behalf of Avaya. End user agrees to indemnify and hold
harmless Avaya, Avaya's agents, servants and employees against
all claims, lawsuits, demands and judgments arising out of, or in
connection with, subsequent modifications, additions or deletions to
this documentation, to the extent made by End user.

Link disclaimer

Avaya is not responsible for the contents or reliability of any linked
websites referenced within this site or Documentation provided by
Avaya. Avaya is not responsible for the accuracy of any information,
statement or content provided on these sites and does not
necessarily endorse the products, services, or information described
or offered within them. Avaya does not guarantee that these links will
work all the time and has no control over the availability of the linked
pages.

Warranty

Avaya provides a limited warranty on Avaya hardware and software.
Please refer to your agreement with Avaya to establish the terms of
the limited warranty. In addition, Avaya’s standard warranty language
as well as information regarding support for this product while under
warranty is available to Avaya customers and other parties through
the Avaya Support website: https://support.avaya.com/helpcenter/
getGenericDetails?detailld=C20091120112456651010 under the link
“Warranty & Product Lifecycle” or such successor site as designated
by Avaya. Please note that if the product(s) was purchased from an
authorized Avaya channel partner outside of the United States and
Canada, the warranty is provided by said Avaya Channel Partner and
not by Avaya.

“Hosted Service” means an Avaya hosted service subscription that
You acquire from either Avaya or an authorized Avaya Channel
Partner (as applicable) and which is described further in Hosted SAS
or other service description documentation regarding the applicable
hosted service. If You purchase a Hosted Service subscription,

the foregoing limited warranty may not apply but You may be

entitled to support services in connection with the Hosted Service

as described further in your service description documents for the
applicable Hosted Service. Contact Avaya or Avaya Channel Partner
(as applicable) for more information.

Hosted Service

THE FOLLOWING APPLIES ONLY IF YOU PURCHASE AN

AVAYA HOSTED SERVICE SUBSCRIPTION FROM AVAYA OR

AN AVAYA CHANNEL PARTNER (AS APPLICABLE), THE TERMS
OF USE FOR HOSTED SERVICES ARE AVAILABLE ON THE
AVAYA WEBSITE, HTTPS://SUPPORT.AVAYA.COM/LICENSEINFO
UNDER THE LINK “Avaya Terms of Use for Hosted Services”

OR SUCH SUCCESSOR SITE AS DESIGNATED BY AVAYA, AND
ARE APPLICABLE TO ANYONE WHO ACCESSES OR USES THE
HOSTED SERVICE. BY ACCESSING OR USING THE HOSTED
SERVICE, OR AUTHORIZING OTHERS TO DO SO, YOU, ON
BEHALF OF YOURSELF AND THE ENTITY FOR WHOM YOU ARE
DOING SO (HEREINAFTER REFERRED TO INTERCHANGEABLY
AS “YOU” AND “END USER”), AGREE TO THE TERMS OF USE.
IF YOU ARE ACCEPTING THE TERMS OF USE ON BEHALF A
COMPANY OR OTHER LEGAL ENTITY, YOU REPRESENT THAT
YOU HAVE THE AUTHORITY TO BIND SUCH ENTITY TO THESE

TERMS OF USE. IF YOU DO NOT HAVE SUCH AUTHORITY,

OR IF YOU DO NOT WISH TO ACCEPT THESE TERMS OF

USE, YOU MUST NOT ACCESS OR USE THE HOSTED SERVICE
OR AUTHORIZE ANYONE TO ACCESS OR USE THE HOSTED
SERVICE.

Licenses

The Global Software License Terms (“Software License Terms”)

are available on the following website https://www.avaya.com/en/
legal-license-terms/ or any successor site as designated by Avaya.
These Software License Terms are applicable to anyone who
installs, downloads, and/or uses Software and/or Documentation. By
installing, downloading or using the Software, or authorizing others to
do so, the end user agrees that the Software License Terms create
a binding contract between them and Avaya. In case the end user is
accepting these Software License Terms on behalf of a company or
other legal entity, the end user represents that it has the authority to
bind such entity to these Software License Terms.

Copyright

Except where expressly stated otherwise, no use should be made
of materials on this site, the Documentation, Software, Hosted
Service, or hardware provided by Avaya. All content on this site, the
documentation, Hosted Service, and the product provided by Avaya
including the selection, arrangement and design of the content is
owned either by Avaya or its licensors and is protected by copyright
and other intellectual property laws including the sui generis rights
relating to the protection of databases. You may not modify, copy,
reproduce, republish, upload, post, transmit or distribute in any way
any content, in whole or in part, including any code and software
unless expressly authorized by Avaya. Unauthorized reproduction,
transmission, dissemination, storage, or use without the express
written consent of Avaya can be a criminal, as well as a civil offense
under the applicable law.

Virtualization

The following applies if the product is deployed on a virtual machine.
Each product has its own ordering code and license types. Unless
otherwise stated, each Instance of a product must be separately
licensed and ordered. For example, if the end user customer or
Avaya Channel Partner would like to install two Instances of the
same type of products, then two products of that type must be
ordered.

Third Party Components

The following applies only if the H.264 (AVC) codec is distributed
with the product. THIS PRODUCT IS LICENSED UNDER THE AVC
PATENT PORTFOLIO LICENSE FOR THE PERSONAL USE OF A
CONSUMER OR OTHER USES IN WHICH IT DOES NOT RECEIVE
REMUNERATION TO (i) ENCODE VIDEO IN COMPLIANCE WITH
THE AVC STANDARD (“AVC VIDEO”) AND/OR (ii) DECODE AVC
VIDEO THAT WAS ENCODED BY A CONSUMER ENGAGED IN A
PERSONAL ACTIVITY AND/OR WAS OBTAINED FROM A VIDEO
PROVIDER LICENSED TO PROVIDE AVC VIDEO. NO LICENSE

IS GRANTED OR SHALL BE IMPLIED FOR ANY OTHER USE.
ADDITIONAL INFORMATION MAY BE OBTAINED FROM MPEG LA,
L.L.C. SEE HTTP://WWW.MPEGLA.COM.

Service Provider

WITH RESPECT TO CODECS, IF THE AVAYA CHANNEL
PARTNER IS HOSTING ANY PRODUCTS THAT USE OR

EMBED THE H.264 CODEC OR H.265 CODEC, THE AVAYA
CHANNEL PARTNER ACKNOWLEDGES AND AGREES THE
AVAYA CHANNEL PARTNER IS RESPONSIBLE FOR ANY AND
ALL RELATED FEES AND/OR ROYALTIES. THE H.264 (AVC)
CODEC IS LICENSED UNDER THE AVC PATENT PORTFOLIO
LICENSE FOR THE PERSONAL USE OF A CONSUMER

OR OTHER USES IN WHICH IT DOES NOT RECEIVE
REMUNERATION TO: (i) ENCODE VIDEO IN COMPLIANCE WITH
THE AVC STANDARD (“AVC VIDEO”) AND/OR (ii) DECODE AVC
VIDEO THAT WAS ENCODED BY A CONSUMER ENGAGED IN A
PERSONAL ACTIVITY AND/OR WAS OBTAINED FROM A VIDEO
PROVIDER LICENSED TO PROVIDE AVC VIDEO. NO LICENSE

IS GRANTED OR SHALL BE IMPLIED FOR ANY OTHER USE.
ADDITIONAL INFORMATION FOR H.264 (AVC) AND H.265 (HEVC)
CODECS MAY BE OBTAINED FROM MPEG LA, L.L.C. SEE HTTP://
WWW.MPEGLA.COM.
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Compliance with Laws

You acknowledge and agree that it is Your responsibility to comply
with any applicable laws and regulations, including, but not limited
to laws and regulations related to call recording, data privacy,
intellectual property, trade secret, fraud, and music performance
rights, in the country or territory where the Avaya product is used.

Preventing Toll Fraud

“Toll Fraud” is the unauthorized use of your telecommunications
system by an unauthorized party (for example, a person who is not a
corporate employee, agent, subcontractor, or is not working on your
company's behalf). Be aware that there can be a risk of Toll Fraud
associated with your system and that, if Toll Fraud occurs, it can
result in substantial additional charges for your telecommunications
services.

Avaya Toll Fraud intervention

If You suspect that You are being victimized by Toll Fraud and You
need technical assistance or support, please contact your Avaya
Sales Representative.

Security Vulnerabilities

Information about Avaya’s security support policies can be
found in the Security Policies and Support section of https://
support.avaya.com/security.

Suspected Avaya product security vulnerabilities are handled
per the Avaya Product Security Support Flow (https://
support.avaya.com/css/P8/documents/100161515).

Trademarks

The trademarks, logos and service marks (“Marks”) displayed in this
site, the Documentation, Hosted Service(s), and product(s) provided
by Avaya are the registered or unregistered Marks of Avaya, its
affiliates, its licensors, its suppliers, or other third parties. Users

are not permitted to use such Marks without prior written consent
from Avaya or such third party which may own the Mark. Nothing
contained in this site, the Documentation, Hosted Service(s) and
product(s) should be construed as granting, by implication, estoppel,
or otherwise, any license or right in and to the Marks without the
express written permission of Avaya or the applicable third party.

Avaya is a registered trademark of Avaya LLC.
All non-Avaya trademarks are the property of their respective owners.

Linux® is the registered trademark of Linus Torvalds in the U.S. and
other countries.

Downloading Documentation

For the most current versions of Documentation, see the Avaya
Support website: https://support.avaya.com, or such successor site
as designated by Avaya.

Contact Avaya Support

See the Avaya Support website: https://support.avaya.com for
Product or Cloud Service notices and articles, or to report a

problem with your Avaya Product or Cloud Service. For a list of
support telephone numbers and contact addresses, go to the Avaya
Support website: https://support.avaya.com (or such successor site
as designated by Avaya), scroll to the bottom of the page, and select
Contact Avaya Support.



https://support.avaya.com/security
https://support.avaya.com/security
https://support.avaya.com/css/P8/documents/100161515
https://support.avaya.com/css/P8/documents/100161515
https://support.avaya.com
https://support.avaya.com
https://support.avaya.com

Contents

Part 1: IP Office Virtual Servers...............ccoooooii i, 8
Chapter 1: IP Office Virtual Servers................ooiiiiiii e 9
Duplicate IP addreSS ISSUE.........iieuuieiiii et ee e e e et e e et e e e et e e e e e e eaaanns 10

[P OffiCE ANYWREIE. ... ..ceeieeeete ettt e e e e e e et e e et e e e et e e eeaaeeeeanneaeees 10
[T F=Y (Yo [ Lo Yot 0 1= o} = 14T ) o RS 10
Downloading dOCUMIENTS. ... ..cuuuieiiiieee i ee e et e e e e e e e e e e e e e e e e eea e e eaneeeeannaaeens 1"
Chapter 2: Virtual server liCeNSINg............ccccooiiiiiiiiiiii e 12
Nodal PLDS Host ID RESHCHONS. .. ..cceeiiiieeeiiiiiie et e e e e e e e 13
Nodal LiceNSE Grace PEeriOd. .......uiiiiiiieiiiie e et e e e et e e e e s e e ea e e e et e e e eaaeeeenans 13
Chapter 3: Differences inoperation....................ccoiiiiiii 14
Original RPM files not installed..............ooiiiiiiiiii e 14

NO USB SUPPOM. ... et e ettt et e e e et e e e e e et e e e e eeasa e e e e seaaaeeeeeessaananns 15

RV A V=T = (o T PR 15
Media Manager arChiViNg...........ceceuueii e ee e e e e e e et e e e e e e e e e e e eeeaa e eeeeeennaaaeaeennn 15
Primary cannot upgrade Other SEIVEIS.........ceuiiii e eeaes 15
Chapter 4: Profiling.............ooooiiiiie et e e e e e e e as 17
Profiling CONSIAErations..........ccu i 17
Default virtual MacChiNg.........ccouuiiiii e e e e e 18
Primary and SECONAArY SEIVEIS..........uuiieieiiiiieeeeee et e e e e et etie e e e e e e eae e e e e e eesa e e e eaeesaaaaaeaanes 19
Server Edition EXpanSion SErVET (L).......cueeuuuiiaiiiiiie e et e e e e e eeaa e e aeeeees 20
Server Edition AppliCation SEIVET..........ciiiuiieiee e 20

IP Office APPlICAtION SEIVEN.......coveeeieii e e e e e e e e e e e e e e e eeenan 21
Part 2: VIVIWAIE..............ooo et e 23
Chapter 5: VMWare FEatUIes.................oiiiiiiiiiiie e 24
Hardware, software and virtual machine requirements.............coooiiiiiiiiiii e 25
VIMOLION FEQUITEMENES. ... ciiii et e e e e e e e et e e e e e e e eaaeeeenas 26
Disk IOPS reqUIrEMENES. ... ..iiiiii et e e e e et e e e e e et e e e e s e e e enaeeeenaeaees 26

A F= T o 0 S 27
High availability..........couuiiieiiee e e 28
Chapter 6: VMware deployment................coooooiiiiiiiiiiiiiiceee e 29
Confirm the system SEtHNGS. ......ccuuuuiiiiiiiiie e e eeeanas 29
DownIoading SOftWAIE. .......cccuuiiiiiii e e e e et e e et e e e e e e e aaees 30
Adding the IP Office Build Certificates..........ccouuuiiiiiiiieiic e 31
Deploying the VMware OVA file (vSphere web client)............c..eeeiiiiiiiiiiii e, 31
Adding an additional VMware hard disk (vSphere web client)..............cooiiiiiiiiiiiiiiies 32
Deploying the VMware OVA file (vSphere desktop client)...............oiiiiiiiiiiiiiiiiiiiiieeeeeeee. 33
Adding an additional VMware hard disk (vSphere desktop client)..............cccceevviiiiiiinieennn. 34
Chapter 7: Virtual machine profiling..............ccooo i, 36
February 2024 Deploying Avaya IP Office Servers as Virtual Machines 4

Comments on this document?



https://onecare.avaya.com/customercare/en/documentation/feedback?formId=1399859460448&p1=S3&p2=DeployingAvayaIPOfficeServersasVirtualMachines&p3=18

Adjusting the VMware RAM MEMOTY .......cuuiieuiiieie et e e e e ennees 37

Adjusting the VMware RAM memory (vSphere web client)............couuiiiiiiiiiiiiinieeeiinnnnn. 38
Adjusting the VMware RAM memory (vSphere desktop client)............cccccoovvieeiinineennnn. 38
Adjusting the VMWare CPU COrES........ccocuuiiiiiiieeeiii et e e e e eeaans 39
Adjusting the VMware CPU Cores (vSphere web client).............cccooeviiiiiiiiiiiiiiiceeennnn. 40
Adjusting the VMware CPU Cores (vSphere desktop client)............ccoeeevveiiiieeeirieinnnnnnnn. 40
Adjusting the VMWare CPU CyCIES........ooiiiiiiiiieeeeiiii ettt e et e e e e e aeees 41
Adjusting the VMware CPU Cycles (vSphere web client)............cccoeveviiiiiiiiieeiiiiceeeenn. 41
Adjusting the VMware CPU Cycles (vSphere desktop client)...........ccceeeviieeiiiieeiiiieennnn. 42
Adjusting the VMware diSK SPaCE...........ceiiiuiiiiii et e et e e e e e e e 42
Adjusting the VMware disk space (vSphere web client)............cccoeevvuiiiiiiieiiiiiieeeiieeee, 43
Adjusting the VMware disk space (vSphere desktop client)............couuiiiiiiiiiiiiiiiiiieiinnnnn. 43
Adjusting the VMware IOPS lIMits......ccuuuuiiiiiiiii e 44
Adjusting the VMware |IOPS limits (vSphere web client)...........cooooiiiiii 45
Adjusting the VMware |IOPS limits (vSphere desktop client).........ccooviiiiiiiiiiiiiii. 45
Disabling @ VMware NetWOrk POIt............coiiiuiiiiiiiiiee e e e e e e e e e e e e e e e e e eaneeeees 46
Disabling a VMware network port (vSphere web client).............ccccoovviiiiiiiiiiiiiceeeees 46
Disabling a VMware network port (vSphere desktop client)............ccceevviviiieeiriiiiiineeenens 47
Powering On a VMware virtual Machine.............oiiiiiiiiniiiiiiei e 48
Part 3: Microsoft Hyper-V............. e 49
Chapter 8: Hyper-V deployment...............ooooiiiiii e 50
Confirm the system SEtNGS. .........uuuiiiiiiiic e e eaaaa 50
Downloading the SOfIWAre...... ... e e 51
Copying and renaming the disk image file.............oooiiiii e 52
Expanding the file hard diSK SiZe...........coouuiiiiii e 52
Creating a new Hyper-V virtual maching...............oeiiiiiiiiiii e 53
Adding an additional hard diSK...............oeiiiiuiiiiiiiie e 54
Hyper-V virtual maching profiling..............ooiiiui i 55
Adjusting the virtual machine's RAM memory settings...........ccooveiiiiiiiiiieeee e 56
Adjusting the virtual Maching's ProCESSOrS. ......c.uiiuiiieiiieie e 56
Starting the virtual Machine.............. e 57
Part 4: Amazon Web Services................cooic 59
Chapter 9: Amazon deployment................oooiiiiiiii e 60
F\ AT IS o] (o] 1113 T TP 61
Creating SECUNLY GrOUPS. .. . oiiiieiieie e e et et e e e ettt e e e e et e e e e e eat e e e e e eeta e e e e eeeena e eeeeeennnnns 61
Launching @ NEW INSEANCE. .........c.uuiiiiii e e e e e e e e e e e e eeaas 62
Changing the SECUILY grOUP........eiiuieeiiiie e et e et e et e e et e e e e e e e e e e et e e e et e e senaeeeaannnns 64
Changing the maching iNSTANCE...........coouuiiiiii e 64
Part 5: Microsoft Azure..................c e 66
Chapter 10: Azure virtual machine deployment..................iiiiii e 67
Downloading the SOftWAre.............iiiiiiiii e e eaaa 67
[oTo fo [ To T o TN (o0 V.U ] R 68
February 2024 Deploying Avaya IP Office Servers as Virtual Machines 5

Comments on this document?



https://onecare.avaya.com/customercare/en/documentation/feedback?formId=1399859460448&p1=S3&p2=DeployingAvayaIPOfficeServersasVirtualMachines&p3=18

Creating @ RESOUINCE GIOUP.......iiiiuieeeiieeeeee e ettt e e et e e e eaa e e e eaa e e e eaaaeeeaaeaeenneeeanaeeesnnaaennn 69

Creating @ Virtual NEIWOTK. ........ceeiei et e e e et e e e e et e e e e eeenannas 69
Uploading the VHD fil t0 AZUIE.........cuuuiieieeeiie e e e 70
Creating a new Azure virtual Maching............cc.iiiiiii i, 70
Adding an Additional Disk for Media Manager..............ceevuuieeieiiieeiieeeeeeee e e e 71
Starting an Azure Virtual Maching.............ouuiiiiiiiiiiie e 72
Creating a copy of an Azure VHD file.......co. e 73
Part 6: Server Configuration.......................o 74
Chapter 11: Initial server configuration..................ccccoco e 75
Connecting to the uninitialized virtual machine...............cccoiii i, 75
Setting the virtual machine's IP address. ..........oooeviiiiiii e 76
Performing Server ignition............ o 77
Adding a certificate 10 the BrOWSET............uuuiiiiiii e 82
Adding a certificate t0 Fir€foX........cccuuiiiiiii i 82

Adding a certificate to Google Chrome..........ccccuuiiiiiiiiiiiie e 82

Adding a certificate to WINdOWS EAQE.........oviiiieiiiiiiieieeii et 83

Adding a certificate 10 Mac Safari...........ooooiiiiiiiiii e 84

IP Office initial CONfIQUIatioN............. oot eeeeees 84
Configuring the server appliCationsS. .........coeuu i e 85
Chapter 12: Adding TTS lanQUAQJES.............uuuuiiiiiiiiiiiiiiiiiiae e 86
Checking the TTS languages installed..............ccooriiiiiiiiii i 86
Downloading the TTS lanQUagES. .......ceuuieeieii et e e e e eees 87
FaNe (o g e Jr= T oAV =T g To [N = o = PP PPPPPT 87
Part 7: Upgrading..............cooo e 89
Chapter 13: Upgrading a virtual machine...................cccciiiiii 90
Downloading the SOFIWAIE......... it e e e e eeee e 91
Backing Up appliCatioNS. .........cuuuiiii e 91
Transferring the SO File. ... .. e e e e e e e e eeenans 92
Chapter 14: Transfer from a Remote File Server...............ccccooiiiiiii, 93
Configuring a remote file SErVEr SOUICE........couuuuiiiiiiiii e e 93
Transferring the ISO from a remote server path ... 93
Upgrading using the Transferred 1ISO file.........cooeuuuiii e 94
Chapter 15: Transfer from a primary server path..........................ccoiii. 96
Uploading an ISO file USING SSH/SFTP.......ccouuiiiie e 96
Transferring the ISO from a primary server path.............cooiiiiiiiiii e 97
Upgrading using the Transferred [ISO file..........o.o e 97
Chapter 16: Upgrade by Transfer from Your Client PC........................c.oooo, 99
Transfer the ISO from the IP Office Web Manager client PC............ccooiiiiiiiiiiiieeeeeee, 99
Upgrading using the Transferred ISO file...........c.uiiiiiiiiiiiii e, 100
Chapter 17: Transfer from a virtual machine DVD.....................oooiiiiiiiice, 101
Connect to an ISO File on the client PCs hard disk............ccooouuuiiiiiiiiiiii e, 102
Mapping the virtual machine's DVD to a local PC ISO file (vSphere desktop client)....... 102
February 2024 Deploying Avaya IP Office Servers as Virtual Machines 6

Comments on this document?



https://onecare.avaya.com/customercare/en/documentation/feedback?formId=1399859460448&p1=S3&p2=DeployingAvayaIPOfficeServersasVirtualMachines&p3=18

Mapping the virtual machine's DVD to a local PC ISO file (vSphere web client)............ 102

Connect to the client PCS DVD driVe......cccuuiiiiii et e e e e eaaa e 103
Mapping the virtual machine’s DVD to the local PC drive (vSphere desktop client)........ 103
Mapping the virtual machine's DVD to local PC drive (vSphere web client)................... 104

Connect to an ISO File in the virtual server datastore...............ccceeveeiieiiiiie e, 104
Uploading an ISO file to the datastore (vSphere desktop client)...........ccccceevveeevennnnnn... 105
Uploading an ISO file to the datastore (vSphere web client).............cceiiiiiiiiiiinnne, 105
Mapping the virtual machine DVD to an ISO file in the datastore (vSphere desktop
(03170 PP URPPRIN 106
Mapping the virtual machine DVD to an ISO file in the datastore (vSphere web client).. 106

Connect to the host Server's DVD driVe..........uuiiiiiiiiiiiiee e 107
Mapping the virtual machine DVD to the host DVD drive (vSphere desktop client)........ 107
Mapping the virtual machine DVD to the host DVD drive (vSphere web client).............. 108

Downloading the ISO from the primary DVD.........ccoouuuiiiiiiiiii e 109

Upgrading using the Transferred ISO file.........oouiiiuiii e 109

Part 8: FUrther Help...............ooo e 111
Chapter 18: Additional Help and Documentation......................cccccciiiiiiiie, 112

Additional Manuals and USEr GUIAES..........c.uiieiiuiieieiiieeeite e eeeie e e e e e e e e e e e e e eanne s 112

(C Tt T N =1 o J P PTRRPP 112

Finding an Avaya BUSIiNESS Partner.............iiiiiiiiiiiie ittt e e e e eeeees 113

Additional IP OffiCe rESOUICES..........ceeeeiiiiiiiieeee e ettt s s e e e e e e e e e e e e e eeeeeareannan 113

B I= 1101 g Te TSP 114

February 2024 Deploying Avaya IP Office Servers as Virtual Machines 7

Comments on this document?



https://onecare.avaya.com/customercare/en/documentation/feedback?formId=1399859460448&p1=S3&p2=DeployingAvayaIPOfficeServersasVirtualMachines&p3=18

Part 1: IP Office Virtual Servers

February 2024 Deploying Avaya IP Office Servers as Virtual Machines

Comments on this document?



https://onecare.avaya.com/customercare/en/documentation/feedback?formId=1399859460448&p1=S3&p2=DeployingAvayaIPOfficeServersasVirtualMachines&p3=18

Chapter 1: IP Office Virtual Servers

Avaya supports the installation of its Linux-based IP Office servers as virtualized servers. Using a
virtual software platform allows the customer's IT staff flexibility to maximize the use of the platform's
hardware to meet the individual needs of each virtual machines it hosts. It also provides them with
access to various tools that ease maintenance and monitoring processes.

 For IP Office R11.1 FP3, IP Office is supported on the following virtual server platforms:
- VMware
- Microsoft Hyper-V
- Amazon Web Services (AWS)
- Microsoft Azure

» Avaya does not provide or support the virtual server software and hardware chosen by the
customer.

» This document outlines the steps required to deploy an IP Office server as a virtual machine.
If deploying multiple virtual machines, follow the order of deployment and configuration in the
Deploying IP Office Server Edition manual.

» Avaya only supports virtual machines using the virtualized server images supplied by Avaya.
Resellers and customers who create their own image files for virtual deployment are solely
responsible for the support and maintenance of those products.

+ In addition to certified IP Office training, the installer and system maintainer must have certified
training on the specific virtual platform type or supported by someone who has the required
certification.

Related links
Duplicate IP address issue on page 10
IP _Office Anywhere on page 10
Related Documentation on page 10

February 2024 Deploying Avaya IP Office Servers as Virtual Machines 9

Comments on this document?



https://documentation.avaya.com/bundle/IPOfficeServerEditionDeploy11_1/page/DocPurposeDeploymentGuide.html
https://onecare.avaya.com/customercare/en/documentation/feedback?formId=1399859460448&p1=S3&p2=DeployingAvayaIPOfficeServersasVirtualMachines&p3=18

IP Office Virtual Servers

Duplicate IP address issue

By default, each new IP Office virtual machine deploys with two virtual network interfaces and
two IP addresses, LAN1 and LAN2. If a duplicate IP address is detected, the IP Office application
stops.

» For example, if you deploy two IP Office virtual machines and only configure the LAN1
address on each, the matching default LAN2 addresses (192.168.43.1) on each causes the
IP Office application on both virtual machines to stop.

» During deployment, you must ensure that the deployment of each IP Office virtual machine is
completed, including setting the required LAN1 and LANZ2 IP addresses, before starting the
deployment of another IP Office virtual machine.

* If the LANZ2 port of an IP Office virtual machine is not required, you can disable it. This
reduces the risks of conflicts. See Disabling a VMware network port on page 46

Related links
IP Office Virtual Servers on page 9

IP Office Anywhere

IP Office Anywhere is a special version of the Linux-based IP Office service intended for product
demonstrations and evaluation. It includes a pre-built and pre-licensed IP Office configuration.

Anywhere can be installed on a physical server or any of the virtual platforms listed above, it is
also supported on VMware Player and Oracle VirtualBox virtual server platforms. See Installing
the IP Office Anywhere Demonstration Software manual for installation procedure.

Related links
IP Office Virtual Servers on page 9

Related Documentation

This section lists the related documents for the products and solutions referenced in this
document.

In addition, you should also refer to the VMware documentation. This is available from VMware
Support Offerings.

» Avaya IP Office™ Platform Solution Description

« Avaya IP Office™ Platform Server Edition Reference Configuration

* Deploying IP Office Server Edition
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Related Documentation

IP Office Administration
« Administering Avaya IP Office™ Platform with Manager

« Administering Avaya IP Office™ Platform with Web Manager

Voicemail Pro
« Administering IP Office Voicemail Pro

* Voicemail Pro Example Exercises
one-X Portal for IP Office
» Administering Avaya one-X Portal for IP Office

Related links
IP Office Virtual Servers on page 9
Downloading documents on page 11

Downloading documents
Procedure

1. Browse to http://support.avaya.com and log in.

2. Select Downloads & Documents.

3. In the Enter Your Product Here box, type IP Office.

4. Use the Choose Release drop-down to select the required IP Office release.
5. Select the content type you want included in the list of documents.

6. Click Enter.

Related links
Related Documentation on page 10
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Chapter 2: Virtual server licensing

This section provides notes on licensing if using PLDS licensing. Virtual servers can also be
deployed using subscriptions.

IP Office systems use licenses to enable various IP Office applications and features. IP Office also
use licenses to enable each Server Edition or IP Office Select server.

For applications and feature, virtualized IP Office servers use the same licenses as used on non-
virtual server deployments. However, for the server's themselves, Virtualized Server Edition and

IP Office Select servers consumes specific Virtualized Server Edition or Virtualized Server Edition
Select licenses respectively rather than standard Server Edition or Server Edition Select licenses.

PLDS licenses can be hosted in the network in one of two ways:

Licensing Mode

Description

WebLM Centralized
Licensing

A PLDS file containing the licenses is uploaded to the WebLM service running on
the network's primary server.

» The licenses are issued or validated against the host ID of the WebLM service.
The host ID is automatically generated from various initial configuration settings
of the server but does not subsequently change.

» Through the IP Office license menus, servers in the network, including the
primary, request licenses from those available.

* Due to its flexibility this is the recommended method of licensing.

Local Nodal Licensing

A PLDS license containing the licenses is uploaded to the IP Office running on the
server.

» The licenses are issued or validated against the PLDS Host ID of the server.
The host ID is automatically generated from various initial configuration settings
of the server. If any of those settings change, the host ID also changes and new
licenses are required. See Nodal PLDS Host ID Restrictions on page 13 and
Nodal License Grace Period on page 13.

Related links

Nodal PLDS Host ID Restrictions on page 13

Nodal License Grace Period on page 13
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Nodal PLDS Host ID Restrictions

Nodal PLDS Host ID Restrictions

If the server is hosting its own licenses, then Avaya validates each license against the server's
unique PLDS Host ID. For an IP Office virtual machine, thelP Office generates the PLDS Host ID
based on several factors:

* Deployment Specific Factors: The PLDS Host ID is partially based on several factors
relating to the particular virtual machine's deployment. Redeploying the virtual machine
changes its PLDS Host ID, thus existing licenses in IP Office configuration becomes invalid.
To move to another virtual server platform without requiring new licenses, use vMotion.

» Configuration Specific Factors: The PLDS Host ID is also partial based on the following
parameters of the virtual machine. Changing any of these parameters changes the virtual
machine's PLDS Host ID:

Host Name

LAN1 IP Address
LAN2 IP Address
Timezone

DHCP Mode

Related links
Virtual server licensing on page 12

Nodal License Grace Period

If the virtual machine already contains nodal licenses and the PLDS Host ID changes, the
licenses remain valid for a 30-day grace period. During those 30 days, if you make more than

five further changes to the configuration parameters existing licenses become invalid immediately.
Therefore, it is recommend that you finalize all these parameters before acquiring any licenses
from Avaya

Related links
Virtual server licensing on page 12
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Chapter 3: Differences in operation

The operations of the virtual servers largely match that of the non-virtual servers. However, this
section details the known differences.
Related links
Original RPM files not installed on page 14
No USB support on page 15
VMware tools on page 15
Media Manager archiving on page 15
Primary cannot upgrade other servers on page 15

Original RPM files not installed

The installation of a non-virtual machine includes copying the original RPM files used for each
component's installation onto the server. Go to Updates menu and click Uninstall to uninstall the
component before reinstalling. The presence of the copied original RPM files allows reinstallation
on a non-virtual machine.

In order to reduce the size of the Avaya OVA file, by not including the original RPM files has the
following effects:

* You cannot reinstall the uninstalled components: You cannot reinstall a component if you
delete the rpPM file it from the server's Updates menu. Instead you need to transfer the
appropriate RPM files to the server first.

* You cannot upgrade other servers from the Primary: If the server is a Primary Server, it
cannot be used to upgrade any Secondary Server or Expansion System (L) servers to match
its software level. However, it can be used to upgrade Expansion System (V2) servers.

You can resolve the issues by: Following the server upgrade process to upload an IS0 image
to the server. This involves transferring a copy of the full ISO to the server, that automatically
unpacks a full set of RPM files necessary to upgrade both Primary and other servers.

Related links
Differences in operation on page 14
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No USB support

No USB support

Avaya does not support features that require access to the virtual machine's USB port. This
includes using the USB port for upgrades and for external music on hold.

Related links
Differences in operation on page 14

VMware tools

VMware tools is used by the virtual machine management software such as the vSphere client
and vCenter to complete requested administrative tasks.

Avaya packages a specific version of VMware Tools as part of the IP Office OVA. This version is
tailored for the IP Office operating system.

You should not upgrade the IP Office virtual machine version of VMware Tools except when
advised by Avaya. Doing so could destabilize operation of the virtual machine and affect its
performance.

Related links
Differences in operation on page 14

Media Manager archiving

When the Media Manager application's disk partition reaches full capacity, its starts using older
recordings archived onto a separate storage and deletes local recordings. A variety of archive
destinations are supported.

For virtual server installations, the Blu-Ray-R and DVD+RW archiving options are not supported.
Instead, the Network Attached Storage (NAS) or cloud based storage archive options must be
used. Refer to the Administering Avaya IP Office™ Platform Media Manager.

Related links
Differences in operation on page 14

Primary cannot upgrade other servers

In a Server Edition network, the Primary Server can upgrade its connected Secondary Server and
Expansion System (L) servers to the same software level as itself. However, this does not work if
the Primary Server is a newly installed virtual machine.
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Differences in operation

This issue is related to the fact the OVA deployment does not include a set of the original RPM files
required for reinstallation of IP Office components. See Original RPM files not installed on page 14

The solution is to first upgrade the Primary Server using any of the documented methods, see
Transferring the 1ISO File on page 92. The upgrade process includes loading all the original RPM
files onto the server which it can then use to upgrade other servers.

Related links
Differences in operation on page 14
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Chapter 4: Profiling

The standard IP Office virtual machine image assumes four CPUs, 3072 MB RAM and a 100 GB
hard disk (see Default virtual machine on page 18). However, you must adjust the resources
allocated to meet the intended role of the virtual machine and to optimize the use of the virtual
server platform's available resources, especially if it is supporting multiple virtual machines.

The IP Office virtual machine requirements are outlined in the following tables. Depending on the
type of virtual server, the stage at which these can be adjusted may vary.

Related links
Profiling considerations on page 17
Default virtual machine on page 18
Primary and secondary servers on page 19
Server Edition Expansion Server (L) on page 20
Server Edition Application Server on page 20
IP Office Application Server on page 21

Profiling considerations

Special factors to consider for profiling are:
* Network Ports:

You must configure all IP Office virtual machines with two Ethernet ports. If you are
using vMotion, additional network port requirement will apply, see vMotion requirements on
page 26.

* Hard disk:

Regardless of the IP Office virtual machine's role, it requires a minimum of 100 GB of
allocated hard drive space. However, if required additional hard disk space can be added.
See Adjusting the VMware disk space on page 42.

- If it is planned to run the Media Manager service on the virtual server, the requirement for
an additional hard disk for Media Manager still applies.

» Disk Storage IOPS Requirements:

February 2024 Deploying Avaya IP Office Servers as Virtual Machines 17

Comments on this document?



https://onecare.avaya.com/customercare/en/documentation/feedback?formId=1399859460448&p1=S3&p2=DeployingAvayaIPOfficeServersasVirtualMachines&p3=18

Profiling

Related li

To maintain acceptable performance, the number of virtual machines using the same disk
storage and the total throughput of those machines must be within the capacity of that
storage. See Disk IOPS requirements on page 26.

Profiling Other Virtual Machines:

It is good practice to monitor the resource utilization of all the virtual machines running in their
infrastructure. Profile all virtual machines running on the virtual server platform to fine-tune
the hardware resources allocated and used. This will improve performance by allocating
resources where they are needed and optimize the use of their virtual infrastructure.

Multiple IP Office Servers:

If deploying servers with the intention of using resiliency, then the hardware resources and
profiling applied to each server must include allowance for the scenarios where users re-
register from one server to the other, effectively increasing the server's user requirements. If
there is a mix of non-virtualized and virtualized machines, then the assignment of resources
to the virtual machine must match the hardware resources available in the non-virtualized
machine.

nks

Profiling on page 17

Defau
The l

It virtual machine

P Office virtual images install a default virtual machine that matches the profiling values for a

typical 200 user Primary Server.

Hardware Resource Allocation Memory Hard Disk
configuration
+ vCPU: 4 « CPU: 5 GHz + Shares: High + Shares: High
+ RAM: 3072MB + Shares: High * Reservation: 2765 MB * Limit: Unlimited
* HDD: 1x 100 GB * Reservation: 8000 Mhz * Limit: Unlimited
 Limit: Unlimited
After deployment of a virtual machine, you should optimize the resources allocated to meet the

actual requirements of the virtual machine. See Profiling on page 17. For example, if the virtual
machine supports only 50 users, you can reduce the allocated processors and RAM memory. This

allow

s for the best use of the overall resources provided by the virtual server platform.

Related links
Profiling on page 17
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Primary and secondary servers

Primary and secondary servers

The following table displays the minimum supported profile values for different IP Office virtual

machine roles in primary and secondary servers:

Server Type Primary and Secondary servers

Users [2] 20 | 100 | 20 50 100 | 200 (500 |1000 | 2000 | 3000

one-X Portal Users [2] - 5 16 20 40 88 175 |351 |703 1500

Voicemail Channels [2] 2 | 12 12 24 49 98 196 | 248 [3

Web Collaboration users | - 5 10 21 42 84 216 512

11 [2]

RAM (MB) Allocated 768 | 2048 | 2684 | 2684 | 3072 | 3072 | 4096 | 5120 | 6144 | 10240 | 14336
[6] [6]

Reserved 625 | 1551 | 2416 | 2416 | 2624 | 2765 | 3358 (4198 | 5376 | 8192 11909

[6] [6]

CPUs 1 2-3 |2-3 |2-3 |24 |35 |35 |4-7 |58 |7-10 11-14

CPU Cycles | Limit 3 5 4 5 7 10 10 14 18 20 25

(127 Reserved |3 |4 |3 |4 |6 |8 |8 12 |15 |17 21

Hard Disk (GB) [8-°] 100 (100 ([(100 |100 |100 |100 |130 (140 (150 (160 160

IOPS [7] 15 | 31 17 18 26 41 71 129 [248 |338 346

AWS Machine Instance [ | m5.large m5.xlarge m5.2xlarge m5.4xlarge

1. Web Collaboration is only supported on the Primary Server.

If there is any profile misalignment between the user and channel quantities, use the
highest-profile that meets all requirements.

More than 250 recording channels with Media Manager requires approximately 12 vCPU
or 30 GHz CPU cycles in total.

4. Each one-X Portal client connection counts as one load.

. The CPU values shown apply to all virtualization platforms. However, for Hyper-V the CPU

values should be increased by 20%.

6. If Media Manager is enabled, add 250MB RAM and increase the typical IOPS values.

10.

February 2024

. Typical IOPS is the average HDD I/O transactions per second during normal operation.

When backup, intense logging or Media Manager are in use, more IOPS are required; 40
to 200 IOPS depending on backup data size, logging rate or recording channels.

. Voicemail Pro requires 0.5 MB per minute for messages, prompts and announcements.

Each user and group mailbox is limited to up to 30 MB (1 hour).

Media Manager requires 60 KB per minute for non-authenticated VRL files and 120 KB per
minute for authenticated VR1A files. Media Manager also reserves 1 GB of space for the
call details database and other operations. Note that more than 250 channels of recording
requires at least 12 vCPUs and 30 GHz CPU cycles.

The quoted AWS machines instances are recommendations only. The range of machine
instances and the capabilities of existing instances change frequently. Therefore, other
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Profiling

instances can be used so long as their capabilities match the profiling resource
requirements.

Related links

Profiling on page 17

Server Edition Expansion Server (L)

Server Type Server Edition Expansion Server (L)
Users 10 50 100 200 500 750
RAM Allocated 1024 1024 1024 1024 1024 1024
Reserved 887 896 900 900 903 906
CPUs 2-3 2-3 2-3 2-3 2-3 2-3
CPU Cycles (GHz) Limit 3 3 5 5 5 6
Reserved 2 2 4 4 4 5
Hard Disk (GB) 100 100 100 100 100 100
IOPS [] | Typical 5 5 6 7 9 11
Notes

1. Typical IOPS is the average HDD 1/O transactions per second during normal operation.
When backup, intense logging or Media Manager are in use, more IOPS are required; 40

to 200 IOPS depending on backup data size, logging rate or recording channels.

Related links

Profiling on page 17

Server Edition Application Server

These profiling values are for an IP Office Application server being used to provide one—X Portal
service support to a Server Edition/Select server that has had its own portal service switched-off in
order to increase its supportable user capacity.

Server Type Server Edition Application Server
one-X Portal Users [1] 50 100 200 500 1000 2000 3000
Web Collaboration users ['] 9 18 35 86 171 342 512
RAM (MB) Allocated 3072 3072 3072 4096 6144 10240 | 14336
Table continues...
February 2024 Deploying Avaya IP Office Servers as Virtual Machines 20

Comments on this document?



https://onecare.avaya.com/customercare/en/documentation/feedback?formId=1399859460448&p1=S3&p2=DeployingAvayaIPOfficeServersasVirtualMachines&p3=18

IP Office Application Server

Server Type Server Edition Application Server
one-X Portal Users [1] 50 100 200 500 1000 2000 3000
Web Collaboration users [1] 9 18 35 86 171 342 512
| Reserved 2703 2703 2703 3548 5386 8555 12272
CPUs 2-3 2-3 2-4 3-5 4-6 4-6 4-6
CPU Cycles (GHz) Limit 6 6 7 10 11 11 11
Reserved 5 5 6 8 9 9 9
Hard Disk (GB) 100 100 100 100 100 100 100
|IOPS [2] 10 10 11 16 18 20 21
Notes

1. If there is any profile misalignment between the user and channel quantities, use the
highest-profile that meets all requirements.

2. Typical IOPS is the average HDD I/O transactions per second during normal operation.
When backup, intense logging or Media Manager are in use, more IOPS are required; 40
to 200 IOPS depending on backup data size, logging rate or recording channels.

Related links
Profiling on page 17

IP Office Application Server

These profiling values are for an IP Office Application Server being used provide services to an
IP500 V2 running in IP Office Preferred Edition mode. This can be used to provide Voicemail Pro,
Media Manager and or one-X Portal support to the IP500 V2.

Server Type IP Office Application servers
one-X Portal Users [1] 50 100 200 750
Voicemail Channels [1] 20 50 100 150
Web Collaboration users [1] 20 50 100 300
RAM (MB) Allocated 3072 3072 4096 7168
Reserved 2739 2739 3420 6144
CPUs 2-3 2-3 3-5 4-7
CPU Cycles (GHz) Limit 5 5 9 13
Reserved 4 4 7 11
Hard Disk (GB) [3- 4 100 100 100 100
|IOPS 18] 34 49 162 318
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Profiling

Notes
1.

If there is any profile misalignment between the user and channel quantities, use the
highest-profile that meets all requirements.

2. Each one-X Portal client connection counts as one load.

3. Voicemail Pro requires 0.5 MB per minute for messages, prompts and announcements.

Each user and group mailbox is limited to up to 30 MB (1 hour).

Media Manager requires 60 KB per minute for non-authenticated vRL files and 120 KB per
minute for authenticated VRLA files. Media Manager also reserves 1 GB of space for the
call details database and other operations. Note that more than 250 channels of recording
requires at least 12 vCPUs and 30 GHz CPU cycles.

Typical IOPS is the average HDD I/O transactions per second during normal operation.
When backup, intense logging or Media Manager are in use, more IOPS are required; 40
to 200 IOPS depending on backup data size, logging rate or recording channels.

Related links
Profiling on page 17
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Part 2: VMware
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Chapter 5: VMware Features

The following VMware features are supported.
Supported Virtual Servers
Avaya supports the IP Office virtual machine on the following virtual server platforms:
* VMware vSphere: The vSphere support is:
- Supported with VMware vSphere ESXi 7.0 and 8.0.

- Support includes the Standard, Enterprise and Enterprise Plus variants. Also support for
Essentials Kit and Essentials Plus Kit variants where available.

Supported VMware Virtual Server Features

» vCenter: VMware vCenter server, is the centralized management tool for the vSphere suite.
It allows the management of multiple host servers and virtual machines on different hosts
through a single console application.

» vMotion: vMotion allows you to move an existing virtual machine from one virtual server
platform to another with minimal interruption to the operation of the virtual machine. For
example, this may be necessary if the existing server platform resources become exhausted.
see vMotion requirements on page 26.

» Snapshot: The virtual machine must be powered off before taking or deleting a snapshot. Note
that running a virtual machine with snapshots degrades its performance. Similarly, deleting
snapshots can take some time to complete and can impact performance.

The virtual machines disk size cannot be changed if any snapshot is taken from the virtual
machine. Any existing snapshots must be deleted first.

* OVA Deployment
» Soft Power Off

* High Availability: Enables the automatic re-establishment of the virtual machine on a new
host server during a failure on or of the original host. See High availability on page 28.

* VMware Tools: Note however that an IP Office specific version of VMware tools is included as
part of the IP Office OVA. See VMware tools on page 15.

vSphere Clients

Traditional host management used the vSphere desktop client installed on a client PC. For vSphere
5.0 onwards, VMware introduced the vSphere web client. The vSphere desktop client is still
supported, however new features released with vSphere 5.1 and higher are only managed using
the vSphere web client.
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Hardware, software and virtual machine requirements

Also, using vSphere desktop client to connect to the ESXi 5.5 host and deploy the OVA will fail.
When the 5.x ESXi host version is managed by a virtual center, the vSphere desktop client's
management capabilities are restricted.
Related links

Hardware, software and virtual machine requirements on page 25

vMotion requirements on page 26

Disk IOPS requirements on page 26

Alarms on page 27

High availability on page 28

Hardware, software and virtual machine requirements

Refer to the following:

* For a searchabile list of hardware platforms, refer to VMware Compatibility Guide. The
platform must support at least 2 Ethernet interfaces.

+ ESXi Hardware Requirements.

» VMware Lifecycle Product Matrix for current supported VMware software.

Avaya provides IP Office virtualization software in an OVA format. The following are high-level
software and hardware requirements:

 Latest VMware vSphere software. See VMware Features on page 24.

» VMware vSphere desktop client software. vCenter is supported but not required unless using
vSphere web client.

» VMware compatible hardware platform.

* Intel-based CPUs from the Xeon family with 2 GHz clock speed or better. 2.4 GHz
recommended.

* The RAM size must satisfy the ESXi requirements in addition to the specific RAM
requirements of the virtual machines deployed. The profiling section lists the requirements
for IP Office virtual machines. 6 GB and higher is recommended.

» 2 Ethernet interfaces (more recommended if using vMotion)
To determine the required virtual server platform:

» Refer to the Default virtual machine on page 18 section to assess the total requirements for
the IP Office virtual machines.

» Add in the requirements for any other virtual machines.
» Add in the underlying requirements for the virtual server software itself.
* Note the minimum requirements above.

* Note the requirements for vMotion. See vMotion requirements on page 26.
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VMware Features

» Assess the compatibility of potential server platforms using the VMware site.

Related links
VMware Features on page 24

vMotion requirements

vMotion allows you to move an existing virtual machine from one virtual server platform to another
with minimal interruption to the operation of the virtual machine. For example, this may be
necessary if the existing server platform resources become exhausted.

For IP Office virtual machines, using vMotion allows you to move the virtual machine without
changing its System Identification and requiring new IP Office licenses. If the virtual machine is
running one-X Portal, any existing sessions may have to log in again after the move.

To use vMotion:

» Each server platform requires 2 Gigabit Ethernet ports with one port dedicated to vMotion
traffic.

* The server platform CPUs must be similar, that is, from the same manufacturer and using
similar processor architectures.

» The Ethernet switch connecting the two servers must be minimum 10Gbps.

» vMotion imposes specific storage requirements. Several options exist including iISCSI and
local storage, among others. See VMware vMotion documentation for detailed requirements.

» To decrease chances of one-X Portal connectivity interruptions, it is recommended that
vMotion operation is done at times of low IP Office use.

Related links
VMware Features on page 24

Disk IOPS requirements

Input/Output Operations Per Second (IOPS) is a measurement of the traffic between a virtual
machine and the disk storage it is using. The following factors should be considered when
assessing the IOPS aspect of the virtual platform:

* The number of virtual machines running on an ESXi host should not exceed the IOPS of
the disk storage divided by 30. For example, a datastore with an IOPS of 150 should only
support up to 5 virtual machines.

* The total maximum IOPS of all the virtual machines must be within the IOPS capacity of the
datastore. To compute how many IOPS the storage supports, you need to know the hard
disk type, RAID configuration, number of drives, connection method, and so on. See Poor
performance and high disk latency with some storage configurations
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Alarms

» By default, no IOPS limit is set for each virtual machine disk. If limits are set, it is important
to understand how the limits are used for all virtual machines using the same datastore. The
limits are aggregated to set an overall limit for the datastore as follows:

- Example: 4 virtual machine disks using the same datastore, each disk set to 100 IOPS.

* As each disk is limited to 100, the total IOPS for the datastore is 400. If disks 1, 2 and 3
are currently using 10 IOPS each, disk 4 could use 370 IOPS without being restricted.

- Example: One disk set to Unlimited (the default), all other disks are set to 100 IOPS.

» As one of the disks is set to unlimited, the potential IOPS for the virtual machine disks
using that datastore are also unlimited.

Exceeding the IOPS capacity of the datastore will lead to unpredictable results for virtual machine
applications using that storage. Whilst a maximum IOPS limit can be applied to each virtual
machine disk, that approach is not recommended for IP Office virtual machines as once again it
will lead to unpredictable behavior.

Related links
VMware Features on page 24

Alarms

The vSphere clients Performance tab displays performance information for individual virtual
machines and for the whole ESXi server. vCenter further extends the capabilities of monitoring
this performance on long term basis.

In addition to the above performance monitors for any virtual machines, for IP Office virtual
machines a number of specific alarms are available that can be output to other applications. The
alarms are warning alarms, critical alarms and OK alarms for when usage returns to below the
alarm threshold.

Alarm Alarm Threshold
Warning Alarm Critical Alarm
CPU Clock Cycles 90% 95%
RAM Memory 85% 97%
Hard Disk Input/Output 15% 25%
Network 15% 25%

You can view and or receive the alarms in a number of ways:

* They appear in the alarms shown by the server's web control menus. see Server Edition
documentation.

» Within the configuration of the IP Office application on the virtual machine, you can select to
output alarms to SNMP, Syslog and or email. IP Office Manager manual.
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VMware Features

» System Status Application displays the alarms when connected to the virtual machine.

Related links
VMware Features on page 24

High availability
VMware High Availability (HA) allows a virtual machine to be automatically re-established on
another host machine if its normal host fails or detects a potential failure. For example:
* Host failures include power failure and ESXi kernel panic.
* A Linux operating system crash on the host server.

Backup is started up after a failure has been detected and takes a approximately 10 minutes to
complete. During the switch any unsaved data and active calls are lost.

Use of this feature is only supported for IP Office Select systems. It requires the customer data
center to include multiple host servers and for those hosts to have access to the same separate
datastore.

HA cannot be combined with IP Office resiliency as the two mechanisms conflict. For example, if
HA is enabled for a Primary Server, no primary resources (phones, hunt groups, voicemail server)
can be supported using IP Office resilience fallback to a Secondary Server.

Related links
VMware Features on page 24
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Chapter 6: VMware deployment

This document outlines the steps required to deploy an IP Office server as a virtual machine.
If deploying multiple virtual machines, follow the order of deployment and configuration in the
Deploying IP Office Server Edition manual.

* In addition to certified IP Office training, the installer and system maintainer must have certified
training on the specific virtual platform type or supported by someone who has the required
certification.

» During deployment, you must ensure that the deployment of each IP Office virtual machine
is completed, including setting the required LAN1 and LAN2 IP addresses, before starting the
deployment of another IP Office virtual machine.

Related links
Confirm the system settings on page 29
Downloading software on page 30
Adding the IP Office Build Certificates on page 31
Deploying the VMware OVA file (vSphere web client) on page 31
Adding an additional VMware hard disk (vSphere web client) on page 32
Deploying the VMware OVA file (vSphere desktop client) on page 33
Adding an additional VMware hard disk (vSphere desktop client) on page 34

Confirm the system settings

Any duplication of IP addresses, even the temporary default IP addresses, causes the IP Office
application to not start and any existing IP Office service to stop.

If using local nodal licensing (see Virtual server licensing on page 12), the virtual server bases the
PLDS Host ID its uses for license validation on several server configuration settings. Hence,
before deploying the virtual machine and obtaining any licenses, you must confirm with the
customer the final values for the following:

* Host Name
« LAN1 IP Address
« LAN2 IP Address

* Timezone
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VMware deployment

+ DHCP Mode
This does not apply if using WebLM centralized licensing.

Related links
VMware deployment on page 29
Hyper-V deployment on page 50

Downloading software

About this task

Avaya make a number of different file available for each IP Office release. For a VMware
deployment, select the following files:

» AvayalPOffice-2023-OVA-CertChain.crt: This certificate must be installed in VMware before
deploying any IP Office . ova file. It is used to perform a security check on the build
certificate of the IP Office . ova files.

» OVA file: You use this type of file for the initial deployment of a VMware virtual machine. The
file is an full machine image.

* TTS ISO: The images used to deploy new virtual machines do not include text-to-speech
(TTS) prompts. To add TTS languages, you need to download and install the additional ISO
files for TTS languages. These are provided as 3 ISO files:

- DVD 1: English, Spanish, French, German, Italian.
- DVD 2: Swedish, Norwegian, Finnish, Dutch, Danish, Portuguese, Greek.
- DVD 3: Chinese, Polish, Russian.

Procedure

1. Browse to http://support.avaya.com and log in.

Click Support by Product and select Downloads.
In the Enter Product Name box, enter TP Of fice and select the displayed match.

Use the Choose Release drop-down to select the required release.

o &~ 0D

From the listed Downloads, select the particular version of the release required (there
may be multiple versions of a release depending on the number of service and feature
packs that have been made available).

6. Click on the required files and follow any further instructions shown by the website and
your browser.

7. Also download and read any documents shown under Related Documents

Next steps

* If not previously done, add the AvayaTIPOffice-2023-0OVA-CertChain.crt certificate
file to VMware (see Adding the IP Office Build Certificates on page 31).
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Adding the IP Office Build Certificates

» Otherwise, proceed to deploying the new virtual machine using the VMware desktop client
(see Deploying the VMware OVA file (vSphere desktop client) on page 33) or web client
(see Deploying the VMware OVA file (vSphere web client) on page 31).

Related links
VMware deployment on page 29

Adding the IP Office Build Certificates

About this task

The latest versions of VMware ESXi 7.0/8.0 now perform security checks on the build certificates
of .ova and .ovf files before allowing you to use those files. See https://kb.vmware.com/s/
article/84240. For IP Office . ova files, you must upload the AvayaIPOffice-2023-0OVA-
CertChain.crt file to VMware.

You only need to perform this process once.

Procedure
1. Download the AvayaIPOffice-2023-0OVA-CertChain.crt file.
2. Login to vCenter as administrator.

3. From the drop-down menu, select Administration > Certificates > Certificate
Management.

4. Click ADD next to Trusted Roots Certificates.
5. Browse and select the AvayaIPOffice-2023-0OVA-CertChain.crt certificate.
Next steps

* Proceed to deploying the new virtual machine using the VMware desktop client (see
Deploying the VMware OVA file (vSphere desktop client) on page 33) or web client (see
Deploying the VMware OVA file (vSphere web client) on page 31).

Related links
VMware deployment on page 29

Deploying the VMware OVA file (vSphere web client)
About this task

Deploying the oVA file to the virtual server platform creates a new virtual machine. Note that,

depending on the speed of the link between the client PC and the virtual server host, this process
can take several hours.
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VMware deployment

Procedure

1. Using the vSphere Web Client, connect to the host server onto which you want to deploy
the OVA.

2. Select Action > All vCenter Actions > Deploy OVF Template.

3. Enter the location of the ova file. If on your PC, click Browse, select the 0vAa image file
and click Open and then click Next.

4. A summary of the OVA is displayed. Click Next.
5. The installer displays the license agreement. Click Accept and then click Next.

6. Enter a name for the virtual machine. This name appears in the VMware server inventory
of virtual machines it is hosting. Click Next.

7. Set the type of disk space usage to Thick Provision Eager Zeroed. Also select the
datastore that the virtual machine should use. Click Next.

8. Select the network connections for the virtual machine. The virtual interfaces should not be
on the same LAN. Click Next.

9. Set the network addresses for the network interfaces. Click Next.

10. The install wizard displays a summary of the deployment settings. Do not select Power on
after deployment check box.

11. Click Finish.

Next steps

After the deployment is complete, the new virtual machine appears in the inventory of virtual
machines.

* If deploying a virtual machine to run Media Manager, you now need to add an additional hard
disk. See Adding an additional VMware hard disk (vSphere web client) on page 32.
» Otherwise, you can now adjust the resource allocation of the virtual machine. See Virtual
machine profiling on page 36.
Related links
VMware deployment on page 29

Adding an additional VMware hard disk (vSphere web
client)

About this task

To run the Media Manager application on the same IP Office server as Voicemail Pro, it must

be provided with and configured to use an additional hard disk. This requirement applies even

is running on a virtual machine. It is recommended that this process is performed before the
server's initial configuration. If the additional disk is added after initial configuration, refer to the
Administering Avaya IP Office™ Platform Media Manager manual for details of initializing the disk.
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Deploying the VMware OVA file (vSphere desktop client)

The minimum supported size is 30 GB. However, the recommended size is 300 GB or higher.

* Media Manager typically requires 60 KB per minute for non-authenticated files and 120 KB
per minute for authenticated files.

* Media Manager also reserves 1 GB of space for the call details database and other
operations.

Procedure

1. Using the vSphere web client, select the virtual machine. For example, select vCenter
Management and in the navigation tree on the left select the virtual machine.

2. Right-click a virtual machine in the inventory and select Edit Settings.

3. On the Virtual Hardware tab, from the New device drop-down select New Hard Disk and
click Add. The hard disk appears in the virtual hardware devices list.

4. Expand New hard disk.

5. Set the hard disk size and select the units (MB or GB) from the drop-down menu.
6. Select the datastore location where you want to store the virtual machine files.

7. For the format select Thick Provision Eager Zeroed and click Next.

Next steps

* You should now adjust the resource allocation of the virtual machine. See Virtual machine
profiling on page 36.

Related links
VMware deployment on page 29

Deploying the VMware OVA file (vSphere desktop client)
About this task

Deploying the OVA file to the virtual server platform creates a new virtual machine. Note that,
depending on the speed of the link between the client PC and the virtual server host, this process
can take several hours.

Procedure
1. Using the VMware vSphere Client, connection go virtual server.
2. Select File and then select Deploy OVF TemplateDeploy OVF Template.
3. Click Browse and select the ova image file and click Open and click Next.
4. The installer displays the license agreement. Click Accept and then click Next.
5

. Enter a name for the virtual machine. This name appears in the VMware server inventory
of virtual machines it is hosting. Click Next.
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VMware deployment

6. Set the type of disk space usage to Thick Provision Eager Zeroed. Also select the
datastore that the virtual machine should use. Click Next.

7. Select the network connections for the virtual machine. The virtual interfaces should not be
on the same LAN. Click Next.

8. Set the network addresses for the network interfaces. Click Next.

9. The install wizard displays a summary of the deployment settings. Do not select Power on
after deployment check box.

10. Click Finish.
Next steps

After deployment is complete, the new virtual machine appears in the inventory of virtual
machines.

* If deploying a virtual machine to run Media Manager, you now need to add an additional hard
disk. See Adding an additional VMware hard disk (vSphere desktop client) on page 34.

» Otherwise, you can now adjust the resource allocation of the virtual machine. See Virtual
machine profiling on page 36.

Related links
VMware deployment on page 29

Adding an additional VMware hard disk (vSphere desktop
client)

About this task

To run the Media Manager application on the same IP Office server as Voicemail Pro, it must

be provided with and configured to use an additional hard disk. This requirement applies even

is running on a virtual machine. It is recommended that this process is performed before the
server's initial configuration. If the additional disk is added after initial configuration, refer to the
Administering Avaya IP Office™ Platform Media Manager manual for details of initializing the disk.

The minimum supported size is 30 GB. However, the recommended size is 300 GB or higher.

* Media Manager typically requires 60 KB per minute for non-authenticated files and 120 KB
per minute for authenticated files.

» Media Manager also reserves 1 GB of space for the call details database and other
operations.

Procedure
1. Using the vSphere desktop client, select the Inventory view.

2. Locate the required virtual machine in the inventory navigation tree on the left. If not
shown, select View > Show VMs in Inventory.

3. Click on the virtual machine.

February 2024 Deploying Avaya IP Office Servers as Virtual Machines 34

Comments on this document?



https://documentation.avaya.com/bundle/AdministeringIPOfficePlatformMeidaManagerR11_1/page/Overview.html
https://onecare.avaya.com/customercare/en/documentation/feedback?formId=1399859460448&p1=S3&p2=DeployingAvayaIPOfficeServersasVirtualMachines&p3=18

Adding an additional VMware hard disk (vSphere desktop client)

Right-click on the virtual machine and select Edit Settings.

On the Virtual Hardware tab, click on Add and select Hard Disk and click Next
Select Create a new virtual disk and click Next.

Set the Disk Size.

Set the Disk Provisioning to Thick Provision Eager Zeroed.

© ® N o g &

Select the Datastore to use. This can be the same datastore or a different one from that
used during the OVA deployment.

10. Click Next.
11. Check the settings are as required. Click Finish.
Next steps

* You should now adjust the resource allocation of the virtual machine. See Virtual machine
profiling on page 36.

Related links
VMware deployment on page 29
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Chapter 7: Virtual machine profiling

After deploying a virtual machine, you must optimize its allocated resources to meet the
requirements of the virtual machine’s role, see Profiling on page 17. This allows for the best use of
the overall resources provided by the virtual server platform.

» For example, if the virtual machine will only support 50 users, you can reduce the allocated
processors and RAM memory.

Attribute Description

Memory You can set the maximum amount of RAM memory that the virtual machine can use. You can
also set how much of that RAM memory the platform guarantees for the virtual machine.

» See Adjusting the VMware RAM memory on page 37

CPU You can configure multiple virtual processor (vCPUs) for a virtual machine. A virtual machine
cannot have more vCPUs than the maximum number of logical CPUs on the host virtual server
platform. The number of logical CPUs is the number of physical processor cores.

» See Adjusting the VMware CPU Cores on page 39

CPU Clock You can set the maximum number of CPU clock cycles that the virtual machine can use. You
Cycles can also set the number of CPU clock cycles guaranteed for the virtual machine. Multiply the
clock cycle of the CPU with the number of allocated virtual CPU processors to determine the
aggregate value and compare it with recommended profiling values.

» See Adjusting the VMware CPU Cycles on page 41

Hard Disk By default the virtual machine is allocated a 100 GB virtual disk. However, this can be
increased if required. Note however that the size cannot be decreased at a later stage.

» See Adjusting the VMware disk space on page 42.

IOPS Input/Output Operations Per Second (IOPS) is a measurement of the traffic between a virtual
machine and the disk storage it is using.

» See Disk IOPS requirements on page 26

Network The IP Office virtual machine deploys with two network interfaces. By default these configure
Ports as LAN1 (192.168.42.1/255.255.255.0) and LAN2 (192.168.43.1/255.255.255.0) when the
virtual machine starts. If the LAN2 port is not required, it can be disabled, see Disabling a
VMware network port on page 46. This reduces the chances of IP address duplication which
causes the IP Office application to not start, see Duplicate IP address issue on page 10.

After profiling, you can power on the virtual machine. See Powering On a VMware virtual
machine on page 48.

* Profiling Other Virtual Machines:
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Adjusting the VMware RAM memory

It is good practice to monitor the resource utilization of all the virtual machines running in their

infrastructure. Profile all virtual machines running on the virtual server platform to fine-tune the
hardware resources allocated and used. This will improve performance by allocating resources
where they are needed and optimize the use of their virtual infrastructure.

* Multiple IP Office Servers:

If deploying servers with the intention of using resiliency, then the hardware resources and
profiling applied to each server must include allowance for the scenarios where users re-
register from one server to the other, effectively increasing the server's user requirements. If
there is a mix of non-virtualized and virtualized machines, then the assignment of resources
to the virtual machine must match the hardware resources available in the non-virtualized
machine.

Related links
Adjusting the VMware RAM memory on page 37
Adjusting the VMware CPU Cores on page 39
Adjusting the VMware CPU Cycles on page 41
Adjusting the VMware disk space on page 42
Adjusting the VMware IOPS limits on page 44
Disabling a VMware network port on page 46
Powering On a VMware virtual machine on page 48

Adjusting the VMware RAM memory

You can set the maximum amount of RAM memory that the virtual machine can use. You can also
set how much of that RAM memory the platform guarantees for the virtual machine. Set these
values to match the virtual server’s profile requirements. See Profiling on page 17.

A Warning:

* The following processes can be used on a new virtual machine that has not been
powered on/started.

* To perform the same actions on an existing virtual machine, it must first be powered
off/stopped before making the adjusting and then powered on/started again. That will
interrupt all services provided by the virtual machine.

Related links
Virtual machine profiling on page 36
Adjusting the VMware RAM memory (vSphere web client) on page 38
Adjusting the VMware RAM memory (vSphere desktop client) on page 38
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Virtual machine profiling

Adjusting the VMware RAM memory (vSphere web client)
Procedure

1. Using the vSphere web client, select the virtual machine. For example, select vCenter
Management and in the navigation tree on the left select the virtual machine.

2. Right-click a virtual machine in the inventory and select Edit Settings.
3. Expand the Memory.

4. In the RAM text box, type the amount of RAM to assign to the virtual machine. See
Profiling on page 17. Select whether the memory is specified in MB or GB.

5. Select the required values for reservations and shares:

» Reservation — This value sets the guaranteed minimum available RAM for the virtual
machine. You cannot set the reservation higher than the maximum memory value. For
IP Office virtual machines, the recommended value is 75-80% of the maximum.

» Shares — Select the virtual machine's relative priority for sharing the server platform
memory. The values are Low, Normal, High and Custom. The more shares a virtual
machine has, the more often it gets a time slice of a memory when there is no
memory idle time. Shares represent a relative priority for the allocation of memory
capacity between virtual machines. For more information about share values, refer to
the VMware Resource Management Guide.

Select Normal only if the IP Office virtual machine has exclusive use of the ESXi host.
However, if other virtual machines utilizing the share mechanism present on the host,
it is imperative that IP Office virtual machine is set to High. IP Office is a real-time
telecommunication software that requires immediate access to hardware resources.

6. Click OK.

Next steps

« If doing as part of installing a new virtual machine, continue with any further profiling required.
When completed, start the virtual machine (see Powering On a VMware virtual machine on
page 48).
Related links
Adjusting the VMware RAM memory on page 37

Adjusting the VMware RAM memory (vSphere desktop client)
Procedure
1. Using the vSphere desktop client, select the Inventory view.

2. Locate the required virtual machine in the inventory navigation tree on the left. If not
shown, select View > Show VMs in Inventory.

3. Click on the virtual machine.
4. Right-click on the virtual machine and select Edit Settings.

5. Select Memory.
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Adjusting the VMware CPU Cores

6. Adjust the maximum memory size for the virtual machine. See Profiling on page 17.

7. Click the Resources tab and select Memory. Allocate the RAM for the virtual machine.
See Profiling on page 17.

» Reservation — This value sets the guaranteed minimum available RAM for the virtual
machine. You cannot set the reservation higher than the maximum memory value. For
IP Office virtual machines, the recommended value is 75-80% of the maximum.

» Shares — Select the virtual machine's relative priority for sharing the server platform
memory. The values are Low, Normal, High and Custom. The more shares a virtual
machine has, the more often it gets a time slice of a memory when there is no
memory idle time. Shares represent a relative priority for the allocation of memory
capacity between virtual machines. For more information about share values, refer to
the VMware Resource Management Guide.

Select Normal only if the IP Office virtual machine has exclusive use of the ESXi host.
However, if other virtual machines utilizing the share mechanism present on the host,
it is imperative that IP Office virtual machine is set to High. IP Office is a real-time
telecommunication software that requires immediate access to hardware resources.

8. Click OK.

Next steps

* If doing as part of installing a new virtual machine, continue with any further profiling required.
When completed, start the virtual machine (see Powering On a VMware virtual machine on
page 48).
Related links
Adjusting the VMware RAM memory on page 37

Adjusting the VMware CPU Cores

You can configure multiple virtual processor (vCPUs) for a virtual machine. A virtual machine
cannot have more vCPUs than the maximum number of logical CPUs on the host virtual server
platform. The number of logical CPUs is the number of physical processor cores.

Note that the CPU core clock speed affects the range selection. When the CPU is at the low end
toward 2 GHz, use the higher number of CPUs. When the CPU speed is higher, for example 3.6
GHz, use the lower number of CPUs.

The CPU core clock speed multiplied by the number of cores, must meet the aggregate CPU cycle
requirements of the virtual machine. See Profiling on page 17.
Related links
Virtual machine profiling on page 36
Adjusting the VMware CPU Cores (vSphere web client) on page 40
Adjusting the VMware CPU Cores (vSphere desktop client) on page 40
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Virtual machine profiling

Adjusting the VMware CPU Cores (vSphere web client)
Procedure

1. Using the vSphere web client, select the virtual machine. For example, select vCenter
Management and in the navigation tree on the left select the virtual machine.

2. Right-click a virtual machine in the inventory and select Edit Settings.
3. Expand the CPU.
4. Select the number of virtual processors for the virtual machine. See Profiling on page 17
5. Click OK.
Next steps

* If doing as part of installing a new virtual machine, continue with any further profiling required.
When completed, start the virtual machine (see Powering On a VMware virtual machine on
page 48).
Related links
Adjusting the VMware CPU Cores on page 39

Adjusting the VMware CPU Cores (vSphere desktop client)
Procedure
1. Using the vSphere desktop client, select the Inventory view.

2. Locate the required virtual machine in the inventory navigation tree on the left. If not
shown, select View > Show VMs in Inventory.

Click on the virtual machine.

Right-click on the virtual machine and select Edit Settings.

Click the Hardware tab and select CPU.

Select the number of virtual processors for the virtual machine. See Profiling on page 17
7. Click OK.

Next steps

* If doing as part of installing a new virtual machine, continue with any further profiling required.
When completed, start the virtual machine (see Powering On a VMware virtual machine on
page 48).
Related links
Adjusting the VMware CPU Cores on page 39
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Adjusting the VMware CPU Cycles

Adjusting the VMware CPU Cycles

You can set the maximum number of CPU clock cycles that the virtual machine can use. You can
also set the number of CPU clock cycles guaranteed for the virtual machine.

Multiply the clock cycle of the CPU with the number of allocated virtual CPU processors
to determine the aggregate value and compare it with recommended profiling values. See

Profiling on page 17.
Related links
Virtual machine profiling on page 36
Adjusting the VMware CPU Cycles (vSphere web client) on page 41
Adjusting the VMware CPU Cycles (vSphere desktop client) on page 42

Adjusting the VMware CPU Cycles (vSphere web client)
Procedure

1. Using the vSphere web client, select the virtual machine. For example, select vCenter
Management and in the navigation tree on the left select the virtual machine.

2. Right-click a virtual machine in the inventory and select Edit Settings.
3. On the Virtual Hardware tab, expand CPU.
4. Allocate the CPU cycles for the virtual machine's vCPUs. See Profiling on page 17

* Reservation — This value sets the guaranteed minimum available RAM for the virtual
machine. You cannot set the reservation higher than the maximum memory value. For
IP Office virtual machines, the recommended value is 75-80% of the maximum.

» Shares — The more shares a virtual machine has, the more often it gets a time slice
of a CPU when there is no CPU idle time. Shares represent a relative priority for the
allocation of memory capacity between virtual machines. For more information about
share values, refer to the VMware Resource Management Guide.

- Select Normal only if the IP Office virtual machine has exclusive use of the ESXi
host. However, if other virtual machines utilizing the share mechanism present on
the host, it is imperative that IP Office virtual machine is set to High. IP Office is
a real-time telecommunication software that requires immediate access to hardware
resources.

5. Click OK.

Next steps

« If doing as part of installing a new virtual machine, continue with any further profiling required.
When completed, start the virtual machine (see Powering On a VMware virtual machine on
page 48).
Related links
Adjusting the VMware CPU Cycles on page 41
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Virtual machine profiling

Adjusting the VMware CPU Cycles (vSphere desktop client)
Procedure
1. Using the vSphere desktop client, select the Inventory view.

2. Locate the required virtual machine in the inventory navigation tree on the left. If not
shown, select View > Show VMs in Inventory.

Click on the virtual machine.

Right-click on the virtual machine and select Edit Settings.

Click the Resources tab and select CPU.

Allocate the CPU cycles for the virtual machine's vCPUs. See Profiling on page 17

2L

» Reservation — This value sets the guaranteed minimum available RAM for the virtual
machine. You cannot set the reservation higher than the maximum memory value. For
IP Office virtual machines, the recommended value is 75-80% of the maximum.

» Shares — The more shares a virtual machine has, the more often it gets a time slice
of a CPU when there is no CPU idle time. Shares represent a relative priority for the
allocation of memory capacity between virtual machines. For more information about
share values, refer to the VMware Resource Management Guide.

- Select Normal only if the IP Office virtual machine has exclusive use of the ESXi
host. However, if other virtual machines utilizing the share mechanism present on
the host, it is imperative that IP Office virtual machine is set to High. IP Office is
a real-time telecommunication software that requires immediate access to hardware
resources.

7. Click OK.

Next steps

* If doing as part of installing a new virtual machine, continue with any further profiling required.
When completed, start the virtual machine (see Powering On a VMware virtual machine on
page 48).
Related links
Adjusting the VMware CPU Cycles on page 41

Adjusting the VMware disk space

By default the virtual machine is allocated a 100 GB virtual disk. However, this can be increased to
meet the virtual server’s profiling requirements. See Profiling on page 17.

Note however:

* The disk size cannot be decreased at a later stage.

» The virtual machines disk size cannot be changed if any snapshot have been taken of the
virtual machine. Any existing snapshots must first be deleted.
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Adjusting the VMware disk space

The process for increasing the disk size takes two parts:

» Using a vSphere client, increase the virtual machine's disk size and then restart the virtual
machine.

» Using the server's IP Office web management menus, indicate to use the additional space
and restart the server.

Related links
Virtual machine profiling on page 36
Adjusting the VMware disk space (vSphere web client) on page 43
Adjusting the VMware disk space (vSphere desktop client) on page 43

Adjusting the VMware disk space (vSphere web client)

Procedure

1. Using the vSphere web client, select the virtual machine. For example, select vCenter
Management and in the navigation tree on the left select the virtual machine.

Right-click a virtual machine in the inventory and select Edit Settings.
Click the Hardware tab and select the hard disk to modify.

Select a Virtual Device Node type from the drop-down menu.

o & DN

To change the size of the disk, enter a new value in the Provisioned Size text box. See
Profiling on page 17.

6. Click OK.
7. Right-click on the virtual machine and select Power > Power Off.

Next steps

* If doing as part of installing a new virtual machine, continue with any further profiling required.
When completed, start the virtual machine (see Powering On a VMware virtual machine on
page 48).
Related links
Adjusting the VMware disk space on page 42

Adjusting the VMware disk space (vSphere desktop client)

Procedure
1. Using the vSphere desktop client, select the Inventory view.

2. Locate the required virtual machine in the inventory navigation tree on the left. If not
shown, select View > Show VMs in Inventory.

3. Click on the virtual machine.
4. Right-click on the virtual machine and select Edit Settings.

5. Click the Hardware tab and select the hard disk to modify.
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Virtual machine profiling

6. Select a Virtual Device Node type from the drop-down menu.

7. To change the size of the disk, enter a new value in the Provisioned Size text box. See
Profiling on page 17.

8. Click OK.

9. Right-click on the virtual machine and select Power > Power Off.

Next steps

* If doing as part of installing a new virtual machine, continue with any further profiling required.
When completed, start the virtual machine (see Powering On a VMware virtual machine on
page 48).
Related links
Adjusting the VMware disk space on page 42

Adjusting the VMware IOPS limits

Input/Output Operations Per Second (IOPS) is a measurement of the traffic between a virtual
machine and the disk storage it is using.

The following factors should be considered when assessing the IOPS aspect of the virtual
platform:

* The number of virtual machines running on an ESXi host should not exceed the IOPS of
the disk storage divided by 30. For example, a datastore with an IOPS of 150 should only
support up to 5 virtual machines.

* The total maximum IOPS of all the virtual machines must be within the IOPS capacity of the
datastore. To compute how many IOPS the storage supports, you need to know the hard
disk type, RAID configuration, number of drives, connection method, and so on. See VMware
Knowledge Base.

» By default no IOPS limit is set for each virtual machine disk. However, an IOPS limit can
be set. If limits are set, it is important to understand how the limits are used for all virtual
machines using the same datastore. The limits are aggregated to set an overall limit for the
datastore as follows:

- Example: 4 virtual machine disks using the same datastore and each disk set to 100 IOPS
As each disk is limited to 100, the total IOPS for the datastore is 400. If disks 1, 2 and 3
are currently using 10 IOPS each, disk 4 could use 370 IOPS without being restricted.

- Example: One disk set to Unlimited (the default), all other disks are set to 100 IOPS As
one of the disks is set to unlimited, the potential IOPS for the virtual machine disks using
that datastore are also unlimited.

Exceeding the IOPS capacity of the datastore will lead to unpredictable results for virtual machine
applications using that storage. Whilst a maximum IOPS limit can be applied to each virtual
machine disk, that approach is not recommended for IP Office virtual machines as once again it
will lead to unpredictable behavior.
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Adjusting the VMware I0OPS limits

A Warning:

* The following processes can be used on a new virtual machine that has not been
powered on/started.

» To perform the same actions on an existing virtual machine, it must first be powered
off/stopped before making the adjusting and then powered on/started again. That will
interrupt all services provided by the virtual machine.

Related links
Virtual machine profiling on page 36

Adjusting the VMware IOPS limits (vSphere web client) on page 45
Adjusting the VMware IOPS limits (vSphere desktop client) on page 45

Adjusting the VMware IOPS limits (vSphere web client)

Procedure

1. Using the vSphere web client, select the virtual machine. For example, select vCenter
Management and in the navigation tree on the left select the virtual machine.

Right-click a virtual machine in the inventory and select Edit Settings.
Click the Virtual Hardware tab and expand Hard Disk.

Select a virtual hard disk from the list.

o & DN

Under Shares, click the drop-down menu and select the relative amount of shares to
allocate to the virtual machine (Low, Normal or High). You can select Custom to enter a
user-defined shares value. Higher shares allow a virtual machine to keep more concurrent
I/O operations pending at the storage device or datastore compared to a virtual machine
with lower shares.

6. Under Limit — IOPS, click the drop-down menu and enter the upper limit of storage
resources to allocate to the virtual machine. By default, IOPS are unlimited. You can
selectLow (500), Normal (1000), or High (2000), or you can select Custom to enter a
user-defined number of shares.

7. Click OK.

Next steps

* If doing as part of installing a new virtual machine, continue with any further profiling required.
When completed, start the virtual machine (see Powering On a VMware virtual machine on
page 48).
Related links
Adjusting the VMware IOPS limits on page 44

Adjusting the VMware IOPS limits (vSphere desktop client)

Procedure

1. Using the vSphere desktop client, select the Inventory view.
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Virtual machine profiling

2. Locate the required virtual machine in the inventory navigation tree on the left. If not
shown, select View > Show VMs in Inventory.

Click on the virtual machine.
Click the Resources tab.
Select Hard Disk.

In Limit — IOPS set the required IOPS limit for each disk the virtual machine uses. See
Profiling on page 17. By default, the limits are set to Unlimited.

7. Click OK.

Next steps

* If doing as part of installing a new virtual machine, continue with any further profiling required.
When completed, start the virtual machine (see Powering On a VMware virtual machine on
page 48).
Related links
Adjusting the VMware IOPS limits on page 44

o o & w

Disabling a VMware network port

The IP Office virtual machine deploys with two network interfaces. By default these configure

as LAN1 (192.168.42.1/255.255.255.0) and LAN2 (192.168.43.1/255.255.255.0) when the virtual
machine starts. If the LAN2 port is not required, it can be disabled. This reduces the chances of IP
address duplication which causes the IP Office application to not start, see Duplicate IP address
issue on page 10.

A Warning:

* The following processes can be used on a new virtual machine that has not been
powered on/started.

» To perform the same actions on an existing virtual machine, it must first be powered
off/stopped before making the adjusting and then powered on/started again. That will
interrupt all services provided by the virtual machine.

Related links
Virtual machine profiling on page 36
Disabling a VMware network port (vSphere web client) on page 46
Disabling a VMware network port (vSphere desktop client) on page 47

Disabling a VMware network port (vSphere web client)

Before you begin

» The following processes can be used on a new virtual machine that has not been powered
on/started.
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Disabling a VMware network port

» To perform the same actions on an existing virtual machine, it must first be powered off/
stopped before making the adjusting and then powered on/started again. That will interrupt all
services provided by the virtual machine.

Procedure

1. Using the vSphere web client, select the virtual machine. For example, select vCenter
Management and in the navigation tree on the left select the virtual machine.

Right-click a virtual machine in the inventory and select Edit Settings.
Select NIC 2.
Deselect Connect at power on.
5. Click OK.
Next steps

A

* If doing as part of installing a new virtual machine, continue with any further profiling required.
When completed, start the virtual machine (see Powering On a VMware virtual machine on
page 48).
Related links
Disabling a VMware network port on page 46

Disabling a VMware network port (vSphere desktop client)

Before you begin

* The following processes can be used on a new virtual machine that has not been powered
on/started.

» To perform the same actions on an existing virtual machine, it must first be powered off/
stopped before making the adjusting and then powered on/started again. That will interrupt all
services provided by the virtual machine.

Procedure
1. Using the vSphere desktop client, select the Inventory view.

2. Locate the required virtual machine in the inventory navigation tree on the left. If not
shown, select View > Show VMs in Inventory.

Click on the virtual machine.
Right-click on the virtual machine and select Edit Settings.
Select NIC 2.
Deselect Connect at power on.
7. Click OK.
Next steps

2B

* If doing as part of installing a new virtual machine, continue with any further profiling required.
When completed, start the virtual machine (see Powering On a VMware virtual machine on
page 48).
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Virtual machine profiling

Related links
Disabling a VMware network port on page 46

Powering On a VMware virtual machine
About this task

Following profiling of the virtual machine, you can power on the virtual server.
Procedure

1. Right-click on the virtual machine.

2. Select Power > Power On.
Next steps

* You can now use a web browser to access the virtual machine. See Connecting to the
uninitialized virtual machine on page 75.

* As part of the deployment of a new virtual machine, you now need to complete the initial
server configuration processes.

Related links
Virtual machine profiling on page 36
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Chapter 8: Hyper-V deployment

IP Office server's are supported as Hyper-V virtual machines.

» Supported virtual machine platforms are Hyper-V running on Windows 2016, Windows 2019
and Windows 2022 servers and on Microsoft Hyper-V Server 2016, 2019 and 2022.

* The installation is performed using a Hyper-V disk image file (VHDX) downloaded from the
Avaya support website.

« Virtual Server Edition/IP Office Select servers require Virtualized Server licenses. See Virtual
server licensing on page 12.

» This document outlines the steps required to deploy an IP Office server as a virtual machine.
If deploying multiple virtual machines, follow the order of deployment and configuration in the
Deploying IP Office Server Edition manual.

+ In addition to certified IP Office training, the installer and system maintainer must have certified
training on the specific virtual platform type or supported by someone who has the required
certification.

» During deployment, you must ensure that the deployment of each IP Office virtual machine
is completed, including setting the required LAN1 and LAN2 IP addresses, before starting the
deployment of another IP Office virtual machine.

Related links
Confirm the system settings on page 29
Downloading the software on page 51
Copying and renaming the disk image file on page 52
Expanding the file hard disk size on page 52
Creating a new Hyper-V virtual machine on page 53
Adding an additional hard disk on page 54
Hyper-V virtual machine profiling on page 55
Starting the virtual machine on page 57

Confirm the system settings

Any duplication of IP addresses, even the temporary default IP addresses, causes the IP Office
application to not start and any existing IP Office service to stop.

If using local nodal licensing (see Virtual server licensing on page 12), the virtual server bases the
PLDS Host ID its uses for license validation on several server configuration settings. Hence,
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Downloading the software

before deploying the virtual machine and obtaining any licenses, you must confirm with the

customer the final values for the following:
* Host Name
* LAN1 IP Address
* LANZ2 IP Address
» Timezone
* DHCP Mode
This does not apply if using WebLM centralized licensing.

Related links
VMware deployment on page 29
Hyper-V deployment on page 50

Downloading the software
About this task

Avaya make a number of different file available for each IP Office release. For a Hypervisor

deployment, select the following files:

» VHDX file: (Hypervisor) This file is actually downloaded as a . zip file from which you can
then extract the . vhdx file. The file is a hard disk image. In the process of creating a new

virtual machine, the file becomes the virtual machine's hard disk.

* TTS ISO: The images used to deploy new virtual machines do not include text-to-speech
(TTS) prompts. To add TTS languages, you need to download and install the additional ISO

files for TTS languages. These are provided as 3 ISO files:

- DVD 1: English, Spanish, French, German, Italian.

- DVD 2: Swedish, Norwegian, Finnish, Dutch, Danish, Portuguese, Greek.

- DVD 3: Chinese, Polish, Russian.
Procedure

1. Browse to http://support.avaya.com and log in.

Click Support by Product and select Downloads.

o &~ 0D

Use the Choose Release drop-down to select the required release.

In the Enter Product Name box, enter IP Of fice and select the displayed match.

From the listed Downloads, select the particular version of the release required (there

may be multiple versions of a release depending on the number of service and feature

packs that have been made available).

6. Click on the required files and follow any further instructions shown by the website and

your browser.
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Hyper-V deployment

7. Also download and read any documents shown under Related Documents
Next steps
* Copy and rename the VHDX file. See Copying and renaming the disk image file on page 52.

Related links
Hyper-V deployment on page 50

Copying and renaming the disk image file
About this task

The file used when creating a new virtual machine becomes the hard disk of that virtual machine.
It cannot then be used to create another new virtual machine. Therefore, it is important to use a
copy of the downloaded file, especially if you are planning to create several virtual machines.

Procedure

1. Download the zipped file for the required software release. See Downloading software on
page 30.

2. Unzip the vHDX file and copy the file to a personal folder. Keep this file as your master
copy for that software release.

3. Save a copy of the file and rename it.

4. Move the renamed file to the folder on the Hyper-V server used to store virtual
machine disks. By default itis C:\Users\Public\Documents\Hyper-V\Virtual
Hard Disks.

Next steps
* Now adjust the disk size. See Expanding the file hard disk size on page 52.

Related links
Hyper-V deployment on page 50

Expanding the file hard disk size

About this task

The default hard disk size set in the downloaded file is 100 GB. This may need to be expanded
depending on planned role of the virtual machine. See Profiling on page 17.

Procedure

1. In Hyper-V Manager, select Action > Edit Disk.
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Creating a new Hyper-V virtual machine

In the Locate Disk menu, enter the file path of the VHDX file or browse to the file and click
Next.

3. In the Choose Action menu select Expand and click Next.
4. In the Configure Disk menu set the new size required and click Next.
5. In the Summary menu check the settings. If okay click Finish.

Next steps

* You can now proceed with using the file to create a new virtual machine. See Creating a new
Hyper-V virtual machine on page 53.

Related links
Hyper-V deployment on page 50

Creating a new Hyper-V virtual machine

About this task

After preparing a new vVHDX file for the virtual machine it can be used to create a new virtual
machine.

Before you begin

* Copy and rename and the download VHDX file, see Copying and renaming the disk image
file on page 52. The file used for the following process becomes the hard disk of the new
virtual machine and so cannot be reused for other virtual machines.

Procedure

1.

2B

Prepare a VHDX file for the new virtual machine . Use the new file for the installation and
not the original file downloaded for the Avaya support site. The file used becomes the hard
disk of the new virtual machine.

From the Hyper-V Manager menu bar, select Action > New > Virtual Machine.
Alternatively, you can go to Actions panel, and select New > Virtual Machine.

Click Next.
Rename the virtual machine you are creating and click Next.
Select Generation 1 and click Next.

In Assign Memory menu, you can set the memory to match the recommend settings for
the server's planned role, see Profiling on page 17. However, you can accept the default
and adjust the memory later during the virtual machine profiling stage and click Next.

In Configure Networking menu, select the network connection that the new virtual
machine should use. Note that the IP Office image expects to obtain an initial IP address
from that network using DHCP. That address can then be changed once the virtual
machine has been started, then click Next.
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Hyper-V deployment

8. In theConnect Virtual Hard Disk menu select Use an existing virtual hard disk .

9. Browse to and select the VHDX file that you prepared for this new virtual machine and click
Next.

10. In the Summary menu, click Finish. The new virtual machine should now appear in the list
of virtual machines.

11. Do not start the virtual machine at this stage.

Next steps

* Do not start the virtual machine at this stage. If intending to support Media Manager, see
Adding an additional hard disk on page 54, otherwise perform any required virtual machine
profiling, see Virtual machine profiling on page 36.

Related links
Hyper-V deployment on page 50

Adding an additional hard disk
About this task

To run the Media Manager application on the same IP Office server as Voicemail Pro, it must

be provided with and configured to use an additional hard disk. This requirement applies even

is running on a virtual machine. It is recommended that this process is performed before the
server's initial configuration. If the additional disk is added after initial configuration, refer to the
Administering Avaya IP Office™ Platform Media Manager manual for details of initializing the disk.

The minimum supported size is 30 GB. However, the recommended size is 300 GB or higher.

* Media Manager typically requires 60 KB per minute for non-authenticated files and 120 KB
per minute for authenticated files.

* Media Manager also reserves 1 GB of space for the call details database and other
operations.

Procedure
1. In the list of virtual machines, select the required virtual machine.

2. Right-click and select Connect.

3. If the virtual machine is already running, stop it by clicking the @. This stops the services
provided by the virtual machine.

In the virtual machine connection window, select File > Settings.
Select IDE Controller 0.

Select Hard Drive and click Add.

Select Virtual hard disk and click New.

N o o &
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Hyper-V virtual machine profiling

8. See the location and name for the file that will be the additional virtual for the virtual
machine.

9. In the Locate Disk menu, enter the name for the new virtual hard disk file and click Next.
10. In the Summary menu check the settings. If okay, click Finish.

Next steps

* Do not start the virtual machine at this stage, instead first perform any required virtual
machine profiling, see Virtual machine profiling on page 36.

Related links
Hyper-V deployment on page 50

Hyper-V virtual machine profiling

After deploying a virtual machine, you must optimize its allocated resources to meet the
requirements of the virtual machine’s role, see Profiling on page 17. This allows for the best
use of the overall resources provided by the virtual server platform.

Attribute Description

Memory You can set the maximum amount of RAM memory that the virtual machine can use. You can
also set how much of that RAM memory the platform guarantees for the virtual machine.

See Adjusting the virtual machine's RAM memory settings on page 56.

Processors You can configure multiple virtual processor (vCPUs) for a virtual machine. A virtual machine
cannot have more vCPUs than the maximum number of logical CPUs on the host virtual server
platform. The number of logical CPUs is the number of physical processor cores.

See Adjusting the virtual machine's processors on page 56.

After profiling, you can start the virtual machine.
* Profiling Other Virtual Machines:

It is good practice to monitor the resource utilization of all the virtual machines running in their
infrastructure. Profile all virtual machines running on the virtual server platform to fine-tune
the hardware resources allocated and used. This will improve performance by allocating
resources where they are needed and optimize the use of their virtual infrastructure.

* Multiple IP Office Servers:

If deploying servers with the intention of using resiliency, then the hardware resources and
profiling applied to each server must include allowance for the scenarios where users re-
register from one server to the other, effectively increasing the server's user requirements. If
there is a mix of non-virtualized and virtualized machines, then the assignment of resources
to the virtual machine must match the hardware resources available in the non-virtualized
machine.
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Related links
Hyper-V deployment on page 50
Adjusting the virtual machine's RAM memory settings on page 56
Adjusting the virtual machine's processors on page 56

Adjusting the virtual machine's RAM memory settings
About this task

You can set the maximum amount of RAM memory that the virtual machine can use. You can also
set how much of that RAM memory the platform guarantees for the virtual machine. Set these
values to match the virtual server’s profile requirements. See Profiling on page 17.

Before you begin

* The following processes can be used on a new virtual machine that has not been powered
on/started.

» To perform the same actions on an existing virtual machine, it must first be powered off/
stopped before making the adjusting and then powered on/started again. That will interrupt all
services provided by the virtual machine.

Procedure
1. In the list of virtual machines, select the required virtual machine.

2. Right-click and select Connect.

3. If the virtual machine is already running, stop it by clicking the @. This stops the services
provided by the virtual machine.

4. In the virtual machine connection window, select File > Settings.
5. Select Memory.

6. Adjust the memory settings to match the recommended settings for the server role. See
Profiling on page 17
7. Click Apply.
Next steps

+ If doing as part of installing a new virtual machine, continue with any further profiling required.
When completed, start the virtual machine (see Starting the virtual machine on page 57).

Related links
Hyper-V virtual machine profiling on page 55

Adjusting the virtual machine's processors
About this task

You can configure multiple virtual processor (vCPUs) for a virtual machine. A virtual machine
cannot have more vCPUs than the maximum number of logical CPUs on the host virtual server
platform. The number of logical CPUs is the number of physical processor cores.
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Starting the virtual machine

Note that the CPU core clock speed affects the range selection. When the CPU is at the low end
toward 2 GHz, use the higher number of CPUs. When the CPU speed is higher, for example 3.6
GHz, use the lower number of CPUs.

The CPU core clock speed multiplied by the number of cores, must meet the aggregate CPU cycle
requirements of the virtual machine. See Profiling on page 17.

Before you begin

» The following processes can be used on a new virtual machine that has not been powered
on/started.

 To perform the same actions on an existing virtual machine, it must first be powered off/
stopped before making the adjusting and then powered on/started again. That will interrupt all
services provided by the virtual machine.

Procedure
1. In the list of virtual machines, select the required virtual machine.

2. Right-click and select Connect.

3. If the virtual machine is already running, stop it by clicking the @. This stops the services
provided by the virtual machine.

4. In the virtual machine connection window, select File > Settings.
5. Select Processor.

6. Adjust the settings to match the recommended settings for the server role. See Profiling on
page 17.

7. Click Apply.

Next steps

* If doing as part of installing a new virtual machine, continue with any further profiling required.
When completed, start the virtual machine (see Starting the virtual machine on page 57).

Related links
Hyper-V virtual machine profiling on page 55

Starting the virtual machine
About this task

Having installed and profiled the new virtual machine, it can be started. This will boot it from the
virtual hard disk file after which the initial IP Office server configuration can be started. See Initial
server configuration on page 75.

Procedure
1. In the list of virtual machines, select the required virtual machine.

2. Right-click and select Connect.
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3. In the virtual machine connection window click on the @ icon or alternatively select
Action > Start to start the virtual machine.

* For a new virtual machine, the virtual machine now goes through the standard Linux
start up process seen on physical servers. This includes partition resizing and other
processes and can take approximately 15 minutes to complete.

» The server displays the address details for further configuration of the server.
Next steps

Use the address to start the initial server configuration process. See Initial server configuration on
page 75.

Related links
Hyper-V deployment on page 50
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Chapter 9: Amazon deployment

IP Office server's are supported as AWS virtual machines, referred to as 'instances'. Each AWS
instance is created using a combination of parts:

Machine Instance:

This defines the processor and memory and other factors of the platform on which

the virtual machine is run. AWS provide a range of different machine instances (https://
aws.amazon.com/ec2/instance-types). The machine instance selected should match the
profiling requirements of the server's intended IP Office role. See AWS profiling on page 61.

Disk Storage:

Storage can be associated with the virtual machine. AWS supports several different types of
storage, however for IP Office it is assumed that a drive or drives using EBS (Elastic Block
Storage) are used.

Amazon Machine Image (AMI):
This file contains the initial image for an IP Office virtual machine.
- The name of the file indicates the release of IP Office software.

- The same image is used to create different types of IP Office server. The server type is
selected during initial server configuration.

Virtual Private Cloud (VPC):

This is the customer's private network within an AWS cloud. It defines the private IP addresses
you can use for the instances launched in the network and provides a range of features for
controlling the traffic between the VPC and the public internet; route tables, internet gateways,
public IP addresses, and so on. This documentation does not cover the configuration of the
customer's VPC.

Security Group:

A security group controls external internet access to virtual machines. Each security group
consists of a set of rules defining the allowed access based on protocol, port and source
address. You can define multiple security groups and then select which one is used by each
particular virtual machine.
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AWS profiling

The process of combining the instances to create a new virtual IP Office server is referred to as
'launching an instance'. During that process, the AWS menus request details of the components to
use and the settings to be applied to those components.

» This document outlines the steps required to deploy an IP Office server as a virtual machine.
If deploying multiple virtual machines, follow the order of deployment and configuration in the
Deploying IP Office Server Edition manual.

+ In addition to certified IP Office training, the installer and system maintainer must have certified
training on the specific virtual platform type or supported by someone who has the required
certification.

» During deployment, you must ensure that the deployment of each IP Office virtual machine
is completed, including setting the required LAN1 and LAN2 IP addresses, before starting the
deployment of another IP Office virtual machine.

Related links
AWS profiling on page 61
Creating security groups on page 61
Launching a new instance on page 62
Changing the security group on page 64
Changing the machine instance on page 64

AWS profiling

The AWS machine instance https://aws.amazon.com/ec2/instance-types and storage specified
when launching a new instance should match the requirements of the virtual server's intended
role. See Profiling on page 17.

Related links
Amazon deployment on page 60

Creating security groups

Prior to launching any IP Office instances you should create several security groups. A security
group consists of a set of rules for what access is allowed based on a set of selected protocols,
ports and source address settings. When launching a new instance, you can select the security
group that it should use.

* When launching a new instance you should use a highly restricted security group you have
created that allow access from as few hosts and protocols as possible. For example, one that
only allows access from your IP address and using HTTPS access to ports 7070/7071. This
is necessary since the new instance boots with default passwords until initial configuration is
completed.
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Amazon deployment

» Once the instance is ignited and initial configuration utility completed, you can then switch
the virtual machine's security group to one you have created for operational systems. For
example, one that allows access from customer addresses using the ports/protocols of the IP
Office services that have been configured on the server. See Changing the security group on
page 64.

Related links
Amazon deployment on page 60

Launching a new instance
About this task

The following is a general example for launching a new virtual instance. The exact process can
vary depending on the customer network requirements.

Procedure

1.
2.
3.

Sign in to your AWS account. Click Services and select EC2.
From the top-right corner, select the zone appropriate to the customer location.

Click Launch Instance and select Community AMIs and enter Avaya as the search
string.

Locate the IP Office AMI and click Select.
» The name of the file indicates the release of IP Office software.

* The same image is used to create different types of IP Office server. The server type is
selected during initial server configuration.

. Select a machine instance that matches the profiling requirements of the virtual machine's

intended role. See AWS profiling on page 61.

. Click Next.

a. In Configure Instance Details page, select the customer's VPC and the subnet in
which the virtual machine should operate.

b. To support eth1, under Network interfaces, click Add Device.

If this option is used, AWS will not automatically assign IP addresses to the ports.
After launching the instance, you can obtain the ethO interface ID and assign a Elastic
IP public IP address which can then be used for ignition and initial configuration.

7. Click Next.

In Add Storage page, set the size of the disk to match the profiling requirements of the
virtual machine's intended role. See AWS profiling on page 61.

Note that currently adjusting the disk size following server ignition is not supported.
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Launching a new instance

If the server is supporting Media Manager, it will require an additional separate storage
volume. To add this, click Add New Volume and specify the size required.

. Click Next.

In Add Tags page, enter any tags that you want associated with this instance.

Tags can be displayed and used in other EC2 menus to display, sort and group matching
resources. . Each tag consists of name and value pairs. For example, you might find it
useful to have tags that indicate the server type, the location it serves and the customer

» Server is Primary
* Site is Paris

» Customer is Example.com

11. Click Next.
12. In Configure Security Group page, select the system installer's security group that you
previously created. See Creating security groups on page 61.
0 Important:
When launching a new instance you should use a highly restricted security group
you have created that allow access from as few hosts and protocols as possible.
For example, one that only allows access from your IP address and using HTTPS
access to ports 7070/7071. This is necessary since the new instance boots with default
passwords until initial configuration is completed.
If you don't select a previously created group, the install process automatically creates
a launch wizard group which only allows SSH access on port 22.
13. Click Review and Launch. Check that the details shown match the requirements for the
server being created. If so, click Launch.
14. Create a new key pair or choose an existing key pair. This provides a security certificate for
secure SSH access to the virtual machine.
15. If creating a new key pair, click Download Key Pair and ensure that you store the
downloaded PEM certificate file in a safe place.
16. Click Launch Instances.
17. If no problems are reported, scroll down the summary form and click View Instances.
© Tip:
Alternatively, select Services > EC2 and from the navigation tree select Instances >
Instances.
The list of your instances displays the new virtual machine.
18. The machine starts by performing initial formatting and partitioning of the storage. This
takes approximately 15 minutes to complete.
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Amazon deployment

Next steps
Proceed with the initial server configuration process. See Initial server configuration on page 75.

Related links
Amazon deployment on page 60

Changing the security group
About this task

You can change the security group assigned to an instance. This allows you to maintain a set of
security groups for different purposes and to flexible switch which security group an instance is
currently using. See Changing the security group on page 64.

Procedure

1. Sign in to your AWS account. Click Services and select EC2.
In the navigation tree on the left select Instances > Instances.
Select the instance for which you want to change the security group.

Click Actions and select Change Security GroupsNetworking.

o & oD

Select the security group that you want the virtual machine to use and click Assign
Security Groups.

Related links
Amazon deployment on page 60

Changing the machine instance
About this task

If necessary, you can change the machine instance on which the virtual machine is running.
© Important:

This processes requires the server to be stopped and restarted and so ends any calls and
operations currently in progress.

Procedure
1. Sign in to your AWS account. Click Services and select EC2.
2. In the navigation tree on the left select Instances > Instances.
3. Select the instance for which you want to change the machine instance it uses.

4. Click Actions and select Instance State > Stop|. When prompted, select Yes, Stop.
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Changing the machine instance

5. Wait until the Instance State has changed to stopped.

6. Click Actions and select Instance Settings > Change Instance Type.
7. Select the type of machine instance required and click Apply.

8. Click Actions and select Instance State > Start. Click Yes, Start.

Related links
Amazon deployment on page 60

February 2024 Deploying Avaya IP Office Servers as Virtual Machines 65

Comments on this document?



https://onecare.avaya.com/customercare/en/documentation/feedback?formId=1399859460448&p1=S3&p2=DeployingAvayaIPOfficeServersasVirtualMachines&p3=18

Part 5: Microsoft Azure
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Chapter 10: Azure virtual machine
deployment

IP Office server's are supported as virtual machines within Microsoft's Azure environment.

» This document outlines the steps required to deploy an IP Office server as a virtual machine.
If deploying multiple virtual machines, follow the order of deployment and configuration in the
Deploying IP Office Server Edition manual.

* In addition to certified IP Office training, the installer and system maintainer must have certified
training on the specific virtual platform type or supported by someone who has the required
certification.

» During deployment, you must ensure that the deployment of each IP Office virtual machine
is completed, including setting the required LAN1 and LAN2 IP addresses, before starting the
deployment of another IP Office virtual machine.

Related links
Downloading the Software on page 67
Logging in to Azure on page 68
Creating a Resource Group on page 69
Creating a virtual network on page 69
Uploading the VHD file to Azure on page 70
Creating a new Azure virtual machine on page 70
Adding an Additional Disk for Media Manager on page 71
Starting an Azure Virtual Machine on page 72
Creating a copy of an Azure VHD file on page 73

Downloading the Software

About this task

Avaya make a number of different file available for each IP Office release. For a Azure
deployment, select the following files:

* VHD file: (Azure) This file is actually downloaded as a . zip file from which you can then
extract the . vhd file.
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Azure virtual machine deployment

* TTS ISO: The images used to deploy new virtual machines do not include text-to-speech

(TTS) prompts. To add TTS languages, you need to download and install the additional ISO

files for TTS languages. These are provided as 3 I1SO files:
- DVD 1: English, Spanish, French, German, Italian.
- DVD 2: Swedish, Norwegian, Finnish, Dutch, Danish, Portuguese, Greek.
- DVD 3: Chinese, Polish, Russian.
Procedure

1. Browse to http://support.avaya.com and log in.
Click Support by Product and select Downloads.
In the Enter Product Name box, enter IP Office and select the displayed match.

Use the Choose Release drop-down to select the required release.

o &~ oD

From the listed Downloads, select the particular version of the release required (there
may be multiple versions of a release depending on the number of service and feature
packs that have been made available).

6. Click on the required files and follow any further instructions shown by the website and
your browser.

7. Also download and read any documents shown under Related Documents

Next steps

» Create a resource group for the IP Office virtual machines. See Creating a Resource
Group on page 69.

Related links
Azure virtual machine deployment on page 67

Logging in to Azure

About this task
For information on Microsoft Azure, see https://docs.microsoft.com/en-us/azure.

Procedure

1. In your web browser, enter https://portal.azure.com.

2. In the Email, Phone and Skype fields, enter your the registered email.
3. In the Password field, type your password.

4. Click Sign In. The web browser displays the Microsoft Azure portal.

Related links
Azure virtual machine deployment on page 67
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Creating a Resource Group

Creating a Resource Group
About this task

A resource group is used to contain sets of related servers. In this case, that can be an IP Office
virtual server or several such servers.

Procedure

1. In the Azure portal, search for resource groups.

2. Click Add to create a new resource group.

3. Complete the required details and click on Review + Create.
Next steps

» Having created a resource group, define the virtual network used by the group. See Creating
a virtual network on page 69.

Related links
Azure virtual machine deployment on page 67

Creating a virtual network
About this task

Once a resource group has been created for the virtual IP Office servers, a virtual network can
also be created.

Before you begin

» Create a resource group for the IP Office virtual machines. See Creating a Resource
Group on page 69.

Procedure

—

. In the Azure portal, search for Virtual Network.

Click Add and select the resource group.

Enter the virtual network name in Name and select the default Region.
Click Next.

Under the IP address tab, add the required IP addresses.

Click Next.

Under the Security tab, select the default security.

Click Review + Create.

© o N o ok~ DN

Click Subnets to assign IP to the virtual machines.
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Azure virtual machine deployment

Next steps
» Upload the IP Office .vhd file. See Uploading the VHD file to Azure on page 70.

Related links
Azure virtual machine deployment on page 67

Uploading the VHD file to Azure

Before you begin

* Define the virtual network for use by servers in the resource group. See Creating a virtual
network on page 69.

Procedure
1. In the Azure portal, select Storage Accounts.
2. Select the storage account to which you want to upload the . vhd file.
* If you do not have a storage account, click Add to create one.

* Note that the selected storage location dictate where subsequent image can be created
and deployed.

3. Under BLOB SERVICE, select Containers.
4. Select the container to which you want to upload the . vhd file.
* If you do not have a storage container, click Add Container to create one.
5. Click Upload and select the . vhd file to upload.
6. Set the Blob type to Page Blob.

7. This process might take a long time depending on your network connection and the
location of your Azure storage account.
Next steps

» The uploaded file can now be used to create virtual machines. See Creating a new Azure
virtual machine on page 70.

Related links
Azure virtual machine deployment on page 67

Creating a new Azure virtual machine

About this task
Follow this procedure to create a new virtual machine from the .vhd file.
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Adding an Additional Disk for Media Manager

Before you begin
» Upload the IP Office .vhd file. See Uploading the VHD file to Azure on page 70.

Procedure

1. Under Settings > Disks, click Create managed disk.

a.

-~ ®© o o T

g.
h.

Select the Resource group.

Enter the disk name in Disk name.

Select the Region.

Select Source type.

Select Source blob. Browse to and select the uploaded . vhd file.
Select the OS type.

Select the require disk size.

Click Review + Create.

2. Under Settings > Disks, click Create VM.

a.
b
C.
d
e

f.

Select the Resource group.

. Enter the virtual machine name in Virtual machine name.

In the Image text box, browse and select the uploaded iposerver file.

. Select the required virtual machine size.

. In the Authentication type, select Password.

Verify the network subnets and click Review + Create.

Next steps

« If intending to support Media Manager, see Adding an Additional Disk for Media Manager on
page 71.

» Otherwise, start the server. See Starting an Azure Virtual Machine on page 72.

Related links

Azure virtual machine deployment on page 67

Adding an Additional Disk for Media Manager
About this task

To run the Media Manager application on the same IP Office server as Voicemail Pro, it must

be provided with and configured to use an additional hard disk. This requirement applies even

is running on a virtual machine. It is recommended that this process is performed before the
server's initial configuration. If the additional disk is added after initial configuration, refer to the
Administering Avaya IP Office™ Platform Media Manager manual for details of initializing the disk.
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Azure virtual machine deployment

The minimum supported size is 30 GB. However, the recommended size is 300 GB or higher.

* Media Manager typically requires 60 KB per minute for non-authenticated files and 120 KB
per minute for authenticated files.

* Media Manager also reserves 1 GB of space for the call details database and other
operations.

Procedure
1. In the Azure portal, search for and select Virtual Machines.
Select the virtual machine from the list.
On the Virtual machine page, select Disks.
On the Disks page, select Add data disk.

In the drop-down for the new disk, select Create disk.

o 0k~ w DN

In the Create managed disk page, type in a name for the disk and adjust the other
settings as necessary.

7. Click Create
8. In the Disks page, select Save to save the new disk configuration for the VM.

9. After Azure creates the disk and attaches it to the virtual machine, the new disk is listed in
the virtual machine's disk settings under Data disks.

Next steps
« Start the server. See Starting an Azure Virtual Machine on page 72.

Related links
Azure virtual machine deployment on page 67

Starting an Azure Virtual Machine

Procedure
1. In the Azure portal, click Virtual Machines.
2. Select the virtual machine(s) to be started.
3. Click Start.

Next steps

* If this is a new server, proceed to initial server configuration. See Initial server
configuration on page 75.

Related links
Azure virtual machine deployment on page 67
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Creating a copy of an Azure VHD file

Creating a copy of an Azure VHD file

About this task

Microsoft recommend that number of concurrent virtual machines deployed using the any
particular snapshot or . vhd file is limited to 20.

If more than 20 virtual machines are required, an additional disk can be created for the additional
virtual machines.

Procedure

1.
2.

2L

14.
15.
16.
17.

In the Azure portal, select All Services.

In the All Services search box, enter disks and then select Disks to display the list of
available disks.

Select the disk that you would like to use. The page for that disk appears.
From the menu at the top, select Create snapshot.
Enter a Name for the snapshot.

Choose a Resource group for the snapshot. You can use either an existing resource
group or create a new one.

For Account type, choose Standard (HDD) or Premium (SSD) storage.

. When done, select Create to create the snapshot.

. After the snapshot has been created, select Create a resource in the left menu.
10.
1.
12.
13.

In the search box, enter managed disk and select Managed Disks from the list.
On the Managed Disks page, select Create.
Enter a Name for the disk.

Choose a Resource group for the disk. You can use either an existing resource group or
create a new one. This selection will also be used as the resource group where you create
the virtual machines from the disk.

For Account type, choose Standard (HDD) or Premium (SSD) storage.
In Source type, select Snapshot.
In the Source snapshot drop-down, select the snapshot created earlier.

Make any other adjustments as needed and then select Create to create the disk.

Related links
Azure virtual machine deployment on page 67
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Part 6: Server Configuration
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Chapter 11: Initial server configuration

Once a new virtual machine has been started, it requires initial configuration to set the servers’
role and complete other key configuration settings. Once these have been complete, it should be
possible to license, configure and manage the virtual machine in the same way as a normal physical
IP Office server.
Related links
Connecting to the uninitialized virtual machine on page 75
Performing server ignition on page 77
Adding a certificate to the browser on page 82
IP Office initial configuration on page 84
Configuring the server applications on page 85

Connecting to the uninitialized virtual machine
About this task

Using a browser, use the process below to login and proceed to Performing Server Ignition. See
Performing server ignition on page 77.

Procedure

1. From a client PC, start the browser and enter https:// followed by the IP address of the
serverand : 7071. For example https://192.168.42.1:7071

* The virtual machines ethO IP address is shown in the console window. By default
the IP address for initial configurationis 192.168.42.1/255.255.255.0. If you
cannot connect to the virtual machine using the default IP address, you need to assign
the virtual machine a valid browseable address. See Setting the virtual machine's IP
address on page 76.

2. The login page is displayed. Enter the user name as root and the password
Administrator.

3. Click Login.
Next steps

* Once connected, the server ignition menus are displayed. See Performing server ignition on
page 77.
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Initial server configuration

Related links
Initial server configuration on page 75
Setting the virtual machine's IP address on page 76

Setting the virtual machine's IP address

A newly deployed IP Office virtual machine uses the following default IP settings: LAN1
192.168.42.1, LAN2 192.168.43.1, Mask 255.255.255.0.

If the default IP settings are incompatible with the existing network where the virtual machine is
being deployed, follow the steps described to change them. Once the settings are correct and the
virtual machine can be accessed with a browser, proceed to perform server ignition.

Before you begin

A Warning:

* If using local nodal licensing, the virtual machine uses its IP address as part of the
unique PLDS Host ID used for licensing. Changing the IP address can change the host
ID, invalidating any existing licenses. See Virtual server licensing on page 12. Therefore,
you must ensure that you have confirmed the final IP address settings before setting
these values.

Procedure
1. To open console page:
» Using the vSphere desktop client:
a. Select Inventory view.

b. Locate the required virtual machine in the inventory navigation tree on the left. If not
shown, select View > Show VMs in Inventory.

c. Click on the virtual machine.

d. Click on the Console tab. All cursor and keyboard action are now applied to the
console window.

» Using the vSphere web client:
a. On the Summary tab, in the Guest OS Details pane, click Launch Console.
b. The virtual machine console opens in a new tab of the Web browser.

c. Click anywhere inside the console window to enable your mouse, keyboard, and
other input devices to work in the console.

2. In the console display, enter the command login.
3. Enter userid root and password Administrator.

4. Once logged in nano /etc/sysconfig/network-scripts/ifcfg-eth0 or ifcfg-eth1, edit the
network settings.

a. Change the BOOTPROTO to static.
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Performing server ignition

b. Set the IP address, mask and default gateway as required.

File: retcssysconfig-network-scripts-ifcfg-ethd

DEVICE="eth@"

BOOTPROTO=-static

IPADDR=192.168.8.22Z _
ETMASK=255.255.255.8

ONBOOT=ye=
PE=Ethernet

IPUGINIT=no

IPUG_AUTOCONF =no

. To save the file, press Ctr1+X and enter y.

5
6. Press enter to save the edited file over the existing file.
7. Enter systemctl restart network.
8. Enterip a s eth0 or ip a s eth1 to check the address.
9. Power off and then power on the virtual machine again.
Next steps

» Using a browser, connect to the server using the new address. See Connecting to the
uninitialized virtual machine on page 75.

Related links
Connecting to the uninitialized virtual machine on page 75

Performing server ignition

About this task
Server ignition is used to set the server's role and other key settings.

Procedure

1. Using a browser, connect to the virtual machine. See Connecting to the uninitialized virtual
machine on page 75.

2. If you accept the license, select | Agree and click Next.
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Initial server configuration

3. Select the role that the server should perform and click Next. The subsequent menus vary
depending on the chosen server type.

IP Office - Ignition

® Primary (Server Edition)

b lEss v Enables Core, one-X Portal and Vaoicemail Pro

Server Type —+

Secondary (Server Edition)
Enables Core and Voicemail Pro

Expansion (Server Edition)
Enables Core only

Application Server
Enables one-X Portal and Voicemail Pro
This configuration is not supported in Server Edition

4. If an additional hard disk was added during the virtual server deployment, details of
the additional hardware appear. Otherwise the menu displays No new hardware
available.

IP Office Server Edition - Ignition

Additional Hardware Info

Accept License v
Name: /devisdb
Server Type v Vendor: VMware
Product: Virtual disk
Hardware —+ User Capacity: 268,435,456,000 bytes [268 GB]
Effective Capacity: 26.00GB
Device Type: disk

Additional Hardware Settings

Format Hard Drive
Partition 1 size (GB):  |7600

Partition 2 size (GB):
Partition 3 size (GB):

Mount Point: Jadditional-hdd#1
Mount Hardware
For Media Manager support, it is recommended to accept the defaults. These are:
a. Leave Format Hard Drive checked.

b. Create a single partition for the whole disk. You can create up to 3 logical partitions on
the physical disk.

c. Leave the Mount Point name as /additional-hdd#1. The full mount path name
for each partition is automatically configured by the system adding /partition1, /
partition2 and so on, as a suffix.

For example /additional-hdd#1/partition1. Note that it is this partition name,
including /partition1, that should be used for Media Manager settings.
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Performing server ignition

d. Select Mount Hardware to have the additional disk automatically mounted.

5. Click Next. Enter the server's network settings.

IP Office Server Edition - Ignition

Accept License

Server Type

New Hardware

Configure Network

Network interface

Assign IP Address:

Automatic (DHCP)

IP Address

MNetmask

192.168.0.214

255.255.255.0

Assign System Gateway:

Gateway:

192.168.0.1

Assign System DNS Servers:

Automatic (DHCP)
Primary DNS

Secondary DNS

Hostname

localhostlocaldomain

* Remember that the LAN1 and LAN2 IP addresses and DHCP mode selections affect the
virtual machine's PLDS Host ID used for licensing . Therefore, if using or planing to use
local nodal licensing, we strongly recommended that before obtaining any licenses, you
ensure that these are set to their final values.

* The ignition process allows you to set the IP address for the LAN1 port only. The LAN2
port initially uses the default address 192.168.43.1. To avoid the duplicate IP address
issue you should set the LAN2 address after ignition. This can be done using IP Office
Manager or IP Office Web Manager.

» For AWS virtual machine these settings affect the private IP address settings of the
instance. They do not alter the public IP address values assigned by AWS.

* Hostname is used as the DNS host name of the server.

- For internal applications, this value must be reachable by DNS within the customer
network. If the server is also supporting external applications, the host name also
needs to be reachable by external DNS. Consult with the customers IT support to
ensure that the host name is acceptable and that routing to the host name has been
configured correctly.

6. Click Next.
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Initial server configuration

7. Set the time source for the server.

IP Office Server Edition - Ignition

Accept License v Use NTP &

NTP Server 0.poal.ntp.org
Server Type v )

Date/Time 2014-07-30 /| 10 28
New Hardware v Timezane EuropelLonden v
Configure Network v

Companding p-law
Time & Companding —+

A-law

* Remember that the virtual machine uses the Timezone for licensing. Therefore, we
strongly recommended that this is set to its final value before obtaining any licenses.

+ Select to use the time provided by an NTP server.

* For a virtual server, if not using NTP, the server takes its time from the virtual server's
host platform rather than allow manual configuration through the server menus.

By default, Secondary Server and Expansion System (L) servers automatically get their
time from the Primary Server and you can only change the Timezone.

» Select the companding setting to use. For telephone systems in North American
locations and Japan, select y-Law (also referred to as U-Law or Mu-Law). For most
other locations, select A-Law.

8. Click Next.

9. Enter and confirm a new password.

IP Office Server Edition - Ignition

Default account passwords are required to be changed.
Accept License

“root” and "security” password

S T

R i New Password:

New Hardware v MNew Password (verify):
View password policy

Configure Network v

Time & Companding v ‘Administrator” password
MNew Password:

Change Password —+

MNew Password (verify):

View password policy

"System"” password

MNew Password:
MNew Password (verify):

View password policy

These are the passwords for various IP Office service accounts and also for the Linux
accounts created on the server. Ensure that you note the passwords set.
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Performing server ignition

10. Click Next.

11. If the selected Server Type was Application Server, select the services provided by the
server.

Avaya |IP Office Application Server

. Select which services will be configured to start automatically
Accept License

¥ Voicemail Pro

Server Type v
#| one-X Portal for IP Office
New Hardware '
Configure Network v
Time & Companding v
Change Password v
Configure Services —+

Unselected services remain installed but not running unless manually started.
12. Click Next.

The menu prompts which security certificate the server should use. This option is not used
for Secondary Server and Expansion System (L) servers.

* If you select Generate CA automatically, you must download the certificate from the
next screen.

* If you select Import CA, click Browse and locate the security certificate file that the
server should use and click Upload.

13. Select whether you want the server to be supported by Avaya through their EASG service
and click Next.

14. Check the displayed summary. Use the Previous and Next options to readjust settings if
necessary.

15. Click Apply.

16. The browser menu will attempt to redirect you to the server IP address you configured
during ignition. Click OK when displayed to access the server's IP Office Web Manager
menus.

AWS: For an AWS virtual machine the browser is redirected to the private IP address of
the server. You need to manually change the browser address back to the instance's public
IP address.

Next steps

+ Add the downloaded certificate to our browser, see Adding a certificate to the browser on
page 82. Then proceed to initial configuration, see |P Office initial configuration on
page 84.
Related links
Initial server configuration on page 75
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Initial server configuration

Adding a certificate to the browser

Browser access to the server uses secure access. The browser used therefore needs to have a
copy of the same CA certificate as used to sign the virtualized server's own identity certificate.

* If the server is using its own auto-generated certificate, you can downloaded the certificate
from the Certificates section of the Settings > General menu. Download the DER-encoded
certificate (a CRT file).

« If the server is using an identity certificate generated elsewhere and then uploaded to the
server, obtain a copy of the CA certificate from the same source.

Related links
Initial server configuration on page 75

Adding a certificate to Firefox on page 82

Adding a certificate to Google Chrome on page 82

Adding a certificate to Windows Edge on page 83

Adding a certificate to Mac Safari on page 84

Adding a certificate to Firefox
Procedure

1.

o &> 0N

6.
7.

Click the = icon and select ¢3. Alternatively, click on the 4 icon if shown on the browser
home page.

Click Advanced and select Certificates.
Click View Certificates.
Click Authorities.

Click Import. Browse to the location of the CRT or PEM file downloaded from the server.
Select the file and click Open.

Select all the check boxes to trust the certificate.
Click OK twice.

Next steps

* If adding the certificate from a newly initialized server, proceed to initial configuration. See |P
Office initial configuration on page 84.

Related links
Adding a certificate to the browser on page 82

Adding a certificate to Google Chrome

Procedure

1.

Click the & icon and select Settings.

2. Click Show advanced settings. Scroll to HTTP/SSL and click Manage certificates.
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Adding a certificate to the browser

3. Click Import.

4. Click Next and browse to the location of the downloaded certificate. Select it and click
Open.

5. Click Next.
6. Click Place all certificates in the following store.

* If using the server's own generated certificate, select the Trusted Root Certification
Authorities.

* If using a certificate from another source, select Intermediate Certification
Authorities.

7. Click Next and then Finish.
8. Click OK, Close.

Next steps

* If adding the certificate from a newly initialized server, proceed to initial configuration. See |P
Office initial configuration on page 84.

Related links
Adding a certificate to the browser on page 82

Adding a certificate to Windows Edge

Procedure
1. From the file browser, open the directory containing the certificate file.

2. Right-click the file and select Install Certificate. You may be prompted for admin
credentials and/or a confirmation prompt.

3. On the first wizard screen, click Next.
4. On the Certificate Store screen select Place all certificates in the following store.

* If using the server's own generated certificate, select the Trusted Root Certification
Authorities.

* If using a certificate from another source, select Intermediate Certification
Authorities.

5. Click OK.

Next steps

+ If adding the certificate from a newly initialized server, proceed to initial configuration. See |P
Office initial configuration on page 84.

Related links
Adding a certificate to the browser on page 82

February 2024 Deploying Avaya IP Office Servers as Virtual Machines 83

Comments on this document?



https://onecare.avaya.com/customercare/en/documentation/feedback?formId=1399859460448&p1=S3&p2=DeployingAvayaIPOfficeServersasVirtualMachines&p3=18

Initial server configuration

Adding a certificate to Mac Safari
Procedure
1. From the browser, open the directory containing the certificate file.
2. Double-click the certificate.

3. You are prompted to store the certificate in the login keychain or the system keychain.
To make the certificate available to all users of this system, select system keychain.

Next steps

« If adding the certificate from a newly initialized server, proceed to initial configuration. See |IP
Office initial configuration on page 84.

Related links
Adding a certificate to the browser on page 82

IP Office initial configuration
About this task

The IP Office service running on the server requires some initial configuration. This is done using
the initial configuration utility (ICU) menu. This menu is automatically shown the first time you login
using either IP Office Web Manager or IP Office Manager.

Procedure
1. Log in to IP Office Web Manager.

a. Enter https:// followed by the server address. Click on the IP Office Web Manager
Web Manager link.

b. Enter the user name Administrator and the password that was created for that
user during ignition.

2. Web manager displays the initial configuration menu for the IP Office service. If this does
not appear, click Solution. Most of the settings are automatically completed using the
values you entered during module ignition.

3. Check the values are as expected. If the module is under centralized management from
Avaya System Manager, select the Centralized Management checkbox. Enter the details
required for Avaya System Manager.

4. Click Apply.

The service is restarted using the values set in the menu. After the restart the browser is
redirected to the normal web management menus.

Related links
Initial server configuration on page 75
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Configuring the server applications

Configuring the server applications

The services provided by the virtual machine can now be configured in the same way as for
non-virtual installations. Refer to the appropriate documentation for Voicemail Pro, one-X Portal
and Media Manager. See Related Documentation on page 10.

Related links
Initial server configuration on page 75
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Chapter 12: Adding TTS languages

The Voicemail Pro application can use Text-to-speech (TTS). However, the IP Office image file
used to create virtual machines does not include the TTS languages. The TTS languages are
downloadable as three separate DVD's. See Downloading software on page 30.

To use TTS languages, you need to upload and install the additional languages on the virtual
machines running the Voicemail Pro application. In a Server Edition network, that applies to the
Primary Server and Secondary Server servers.

A Warning:
» TTS files from pre-11.1 releases are not compatible with R11.1.

» During this process, the server needs to restart the voicemail service each time it installs a
new TTS language.
Related links
Checking the TTS languages installed on page 86
Downloading the TTS languages on page 87
Adding a new language on page 87

Checking the TTS languages installed

Procedure
1. Access the server's web control/platform view menus.
2. Select Updates.

3. In the list of Services, each TTS language is shown with the prefix TTS.

Related links
Adding TTS languages on page 86
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Downloading the TTS languages

Downloading the TTS languages
About this task

Avaya make a number of different file available for each IP Office release. For TTS, select the
following files:

* TTS ISO: The images used to deploy new virtual machines do not include text-to-speech
(TTS) prompts. To add TTS languages, you need to download and install the additional ISO
files for TTS languages. These are provided as 3 ISO files:

- DVD 1: English, Spanish, French, German, Italian.
- DVD 2: Swedish, Norwegian, Finnish, Dutch, Danish, Portuguese, Greek.
- DVD 3: Chinese, Polish, Russian.

Procedure

1. Browse to http://support.avaya.com and log in.

Click Support by Product and select Downloads.
In the Enter Product Name box, enter TP Of fice and select the displayed match.

Use the Choose Release drop-down to select the required release.

o &> 0D

From the listed Downloads, select the particular version of the release required (there
may be multiple versions of a release depending on the number of service and feature
packs that have been made available).

6. Click on the required files and follow any further instructions shown by the website and
your browser.

7. Also download and read any documents shown under Related Documents

Related links
Adding TTS languages on page 86

Adding a new language
About this task

Note that this process causes the voicemail service to restart, ending all calls currently being
handled by the voicemail service.

Procedure
1. Access the server's web control/platform view menus.
2. Select Settings > General.

3. In the Software Repositories section, click on the Browse button for Application.
Browse to and select the RPM file for the required language and click OK.
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Adding TTS languages

4. Click Add.
5. Select Updates.
6. In the Services section, locate the newly added TTS language and click Install.

Related links
Adding TTS languages on page 86
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Part 7: Upgrading
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Chapter 13: Upgrading a virtual machine

Server Edition software supports several methods for upgrading. For virtual machines, the
supported method is to upload the new ISO file to the virtual server, using one of the methods
below, and then select upgrade within the IP Office Web Manager menus.

Method

Summary

Transfer from a virtual DVD

Upload the ISO file from a virtual DVD drive. You can connect an ISO
file to the virtual machine's DVD drive in several ways.

Transfer from a remote file server

Upload the ISO file to the server from a file server (http, https, ftp, sftp
or scp).

Transfer via SSH/SFTP to the virtual Upload the ISO file directly to a folder on the server using SFTP.

machine

Direct transfer

Upload the ISO file to the server using the IP Office Web Manager
browser session.

A Warning:

* Not Supported for Upgrades from Pre-R11.1:

This method of upgrading is not supported for upgrading from pre-R11.1 releases. For
example, from R11.0 to R11.1. The server must be upgraded using the processes in the
Upgrading Linux-Based IP Office Systems to R11.1 manual.

* WARNING: Boot from DVD Upgrades:

For non-virtual IP Office servers, the server can boot from a DVD copy of the ISO. The
menu presented includes an option to upgrade. However, for virtual machines this method
of upgrading is not supported.

In a Server Edition network consisting of several servers, you can use IP Office Web Manager to
first upgrade the primary server. The files on the primary are then used to upgrade its associated
secondary, expansion and application servers. Note that this is not possible from a newly installed

virtual primary server.

The VMware Snapshot feature can be used to provide a more robust upgrade process by providing
a fall back point to the previous instance of the virtual machine. See VMware Features on page 24.

Related links

Downloading the software on page 91
Backing up applications on page 91
Transferring the 1ISO File on page 92
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Downloading the software

Downloading the software
About this task

Virtual server upgrades use the same ISO file as used for non-virtual servers.

+ ISO file: You can use this type of file to upgrade an existing virtual machine, see Upgrading
a virtual machine on page 90. Before using an ISO file, you must backup all applications data
and check that you have understood any additional requirements mentioned in the IP Office
Technical Bulletin for the IP Office release. IP Office Technical Bulletins are downloadable
from the same website as the software.

Procedure

1. Browse to http://support.avaya.com and log in.

2. Click Support by Product and select Downloads.

3. In the Enter Product Name box, enter TP Of fice and select the displayed match.
4. Use the Choose Release drop-down to select the required release.
5

. From the listed Downloads, select the particular version of the release required (there
may be multiple versions of a release depending on the number of service and feature
packs that have been made available).

6. Click on the required files and follow any further instructions shown by the website and
your browser.

7. Also download and read any documents shown under Related Documents
Next steps
» Backup the existing servers. See Backing up applications on page 91.

Related links
Upgrading a virtual machine on page 90

Backing up applications

You can configure IP Office Web Manager to backup the servers in a Server Edition network to a
another servers. Refer to the Deploying Avaya IP Office Server Edition Manual manual.

Next steps

» Once you have backed up the servers, proceed with transferring the new ISO file to the
server. See Transferring the ISO File on page 92.

Related links
Upgrading a virtual machine on page 90
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Upgrading a virtual machine

Transferring the ISO File

Having backed up the applications, the next stage is to transfer the ISO file to the Primary Server.
As previously stated, there are number of different methods supported for a virtual machine.

* Transfer from the virtual machine DVD:

- For a physical server, this method uses an ISO file burnt to DVD and placed in the server's
DVD drive. For a virtual machine, there are several methods to connect an ISO file to the
virtual machine's DVD drive. See Transfer from a virtual machine DVD on page 101.

» Transfer from a remote file server:

- Thorough the IP Office Web Manager menus, you can configure the server with the details
of remote file servers from which it can upload an 150 file. See Transfer from a Remote
File Server on page 93.

» Transfer from a primary server path:

- Using SFTP, you can upload the ISO file directly to the server. Within IP Office Web
Manager, you can then use the server file path to download the file. See Transfer from a
primary server path on page 96.

* Transfer from the Web Manage client PC:

- You can transfer an ISO file during a connected IP Office Web Manager session. See
Transfer the ISO from the IP Office Web Manager client PC on page 99.

Related links
Upgrading a virtual machine on page 90
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Chapter 14: Transfer from a Remote File
Server

You can upload an 150 file to the virtual server from a previously configured file server. The process
for this is the same for virtual and non-virtual machines. See Server Edition documentation for full
details.

Related links
Configuring a remote file server source on page 93

Transferring the 1SO from a remote server path on page 93
Upgrading using the Transferred ISO file on page 94

Configuring a remote file server source
Procedure

1. Login to IP Office Web Manager.

Click on the Solution Settings drop-down and select Remote Server Options.
IP Office Web Manager lists the currently configured remote servers.

Click Add Remote Server.

Enter details for the remote file server hosting the 150 file. The details required vary
depending on the protocol used by the server.

o > oD

6. Click OK. The new remote server is now included in the list of remote servers.
7. Click Close.

Related links
Transfer from a Remote File Server on page 93

Transferring the ISO from a remote server path
Procedure

1. Login to IP Office Web Manager.
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Transfer from a Remote File Server

o &~ DN

7.
8.

Click Solution.
Click on the Actions drop-down and select Transfer ISO.
Click Transfer from and select Remote Location.

Click Select Remote Server and select the previously configured remote file server from
the list.

In the File Path field, enter the path to the ISO file on that server.
Click OK. The menu shows the progress of the download.

The servers listed in the Solution overview show an 4 icon and Upgrade Available.

Next steps

* Proceed with upgrading from the uploaded file. See Upgrading using the Transferred ISO
file on page 94.

Related links
Transfer from a Remote File Server on page 93

Upgrading using the Transferred ISO file

About this task

Having downloaded an 1s0 file to the server , IP Office Web Manager indicates those servers

it can upgrade. It does this by showing an 4 icon and Upgrade Available next to the server's
details on the Solution menu.

A Warning:

* Not Supported for Upgrades from Pre-R11.1:

This method of upgrading is not supported for upgrading from pre-R11.1 releases. For
example, from R11.0 to R11.1. The server must be upgraded using the processes in the
Upgrading Linux-Based IP Office Systems to R11.1 manual.

Procedure

. Login to IP Office Web Manager.
. Select Solution.

. Select the checkbox next to each server to upgrade. Upgrades require the primary server

upgraded before any other servers.

. Click on the Actions drop down and select Upgrade.

5. The upgrade process typically requires the IP Office server to restart, ending the current

web browser connection. If this occurs, login to IP Office Web Manager again to check on
the status of the upgrade.
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Upgrading using the Transferred ISO file

Next steps
If necessary, repeat the process to upgrade all the servers.

Related links
Transfer from a Remote File Server on page 93
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Chapter 15: Transfer from a primary server
path

SFTP/SSH can be used to upload an ISO file directly to a folder on the virtual machine. The upload
process is typically slow, several hours, but reliable.

Related links
Uploading an ISO file using SSH/SFTP on page 96

Transferring the ISO from a primary server path on page 97
Upgrading using the Transferred ISO file on page 97

Uploading an ISO file using SSH/SFTP

Procedure

1. Start your SFTP or SSH file application and connect to the IP Office Application Server PC.
The exact method depends on the application you are using.

a. Enter the details for the IP Office Application Server:
* The Host Name is the IP address of the IP Office Application Server.
* The User Name is Administrator.
* The Protocol is SFTP/SSH.

* The Port is 22. If this is the first time the application has connected to the server,
accept the trusted key.

b. If this is the first time the application has connected to the IP Office Application Server,
accept the trusted key.

c. When prompted, enter the user password.
2. The default folder displayed after logging in is /home/Administrator.
3. Upload the ISO file to the server.

Related links
Transfer from a primary server path on page 96
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Transferring the 1ISO from a primary server path

Transferring the ISO from a primary server path
Procedure

1. Login to IP Office Web Manager.
Click Solution.
Click on the Actions drop-down and select Transfer ISO.

Click Transfer from and select Primary Server Path.

o &> 0N

In the File Path field, enter the path to the previously uploaded ISO file. For example, /
home/Administrator/Downloads/abe-11.1.1-209 el6.1iso.

6. Click OK. The menu shows the progress of the download.
7. The servers listed in the Solution overview show an 4 icon and Upgrade Available.

Next steps

* Proceed with upgrading from the uploaded file. See Upgrading using the Transferred ISO
file on page 97.

Related links
Transfer from a primary server path on page 96

Upgrading using the Transferred ISO file

About this task

Having downloaded an 150 file to the server , IP Office Web Manager indicates those servers

it can upgrade. It does this by showing an 4 icon and Upgrade Available next to the server's
details on the Solution menu.

A Warning:
* Not Supported for Upgrades from Pre-R11.1:

This method of upgrading is not supported for upgrading from pre-R11.1 releases. For
example, from R11.0 to R11.1. The server must be upgraded using the processes in the
Upgrading Linux-Based IP Office Systems to R11.1 manual.

Procedure
1. Login to IP Office Web Manager.
2. Select Solution.

3. Select the checkbox next to each server to upgrade. Upgrades require the primary server
upgraded before any other servers.

4. Click on the Actions drop down and select Upgrade.
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Transfer from a primary server path

5. The upgrade process typically requires the IP Office server to restart, ending the current
web browser connection. If this occurs, login to IP Office Web Manager again to check on
the status of the upgrade.

Next steps
If necessary, repeat the process to upgrade all the servers.

Related links
Transfer from a primary server path on page 96
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Chapter 16: Upgrade by Transfer from Your
Client PC

This method of upgrade uses an . iso file transferred directly from your PC through the browser.

Related links
Transfer the 1ISO from the IP Office Web Manager client PC on page 99
Upgrading using the Transferred ISO file on page 100

Transfer the ISO from the IP Office Web Manager client PC

We do not recommend this method of uploading an 150 file to the server for remote maintenance
of servers not located on the same local network as the PC. The file transfer is slow and does

not continue or automatically resume if the IP Office Web Manager session disconnects during the
transfer.

Procedure
1. Login to IP Office Web Manager.
Click Solution.
Click on the Actions drop-down and select Transfer ISO.
Click Transfer from and select Client Machine.

For the Select ISO field, click Browse. Locate and select the 150 file and click Open.

o a0~ Db

Click OK. The menu shows the progress of the download.
7. The servers listed in the Solution overview show an 4 icon and Upgrade Available.

Next steps

* Proceed to upgrading from a downloaded ISO. See Upgrading using the Transferred 1ISO
file on page 100.

Related links
Upgrade by Transfer from Your Client PC on page 99
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Upgrade by Transfer from Your Client PC

Upgrading using the Transferred ISO file

About this task

Having downloaded an 150 file to the server , IP Office Web Manager indicates those servers
it can upgrade. It does this by showing an 4 icon and Upgrade Available next to the server's
details on the Solution menu.

A Warning:
* Not Supported for Upgrades from Pre-R11.1:

This method of upgrading is not supported for upgrading from pre-R11.1 releases. For
example, from R11.0 to R11.1. The server must be upgraded using the processes in the
Upgrading Linux-Based IP Office Systems to R11.1 manual.

Procedure
1. Login to IP Office Web Manager.
2. Select Solution.

3. Select the checkbox next to each server to upgrade. Upgrades require the primary server
upgraded before any other servers.

4. Click on the Actions drop down and select Upgrade.

5. The upgrade process typically requires the IP Office server to restart, ending the current
web browser connection. If this occurs, login to IP Office Web Manager again to check on
the status of the upgrade.

Next steps
If necessary, repeat the process to upgrade all the servers.

Related links
Upgrade by Transfer from Your Client PC on page 99
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Chapter 17: Transfer from a virtual machine
DVD

One of the options for downloading an ISO image used by IP Office Web Manager is to download
the I1SO file from the primary server's DVD drive. To use this option for a virtual machine, you must
first connect the virtual machine's DVD drive to the ISO file.

The VMware client supports the following options for connecting the virtual machine's DVD drive
to a source. This section lists the different methods in order of preference based on speed and
reliability:

« Connect to an ISO file on the client PCs hard disk — This method connects the virtual
machine's DVD drive to an 150 file on the hard disk of the VMware client PC. The time to
complete the upgrade depends on the speed between the vSphere host and the client PC. See
Connect to an ISO File on the client PCs hard disk on page 102.

» Connect to the client PC DVD drive — This method connects the virtual machine's DVD drive
to the DVD drive of the PC running the VMware client PC. The time to complete the upgrade
depends on the speed between the vSphere host and the client PC. See Connect to the client
PCs DVD drive on page 103.

* Connect to an ISO file in the virtual server datastore — This method connects the virtual
machine's DVD drive to an 150 file previously uploaded to the virtual server datastore. For
remote upgrades, this method is the most reliable. In addition, if multiple virtual machines use
the same datastore, they can access the same 150 file. See Connect to an ISO File in the
virtual server datastore on page 104.

* Connect to the VMware server's DVD drive — This method connects the virtual machine's
DVD drive to a DVD drive on the VMware server PC. This method requires physical access to
a DVD drive on the VMware server. See Connect to the host server's DVD drive on page 107.

Related links
Connect to an ISO File on the client PCs hard disk on page 102
Connect to the client PCs DVD drive on page 103
Connect to an ISO File in the virtual server datastore on page 104
Connect to the host server's DVD drive on page 107
Downloading the ISO from the primary DVD on page 109
Upgrading using the Transferred ISO file on page 109
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Transfer from a virtual machine DVD

Connect to an ISO File on the client PCs hard disk

This method maps the DVD drive of the virtual machine to an ISO file on the PC running the
VMware client.

Related links
Transfer from a virtual machine DVD on page 101

Mapping the virtual machine's DVD to a local PC I1SO file (vSphere desktop client) on page 102
Mapping the virtual machine's DVD to a local PC ISO file (vSphere web client) on page 102

Mapping the virtual machine's DVD to a local PC ISO file (vSphere
desktop client)
Procedure
1. Place the 150 file in a folder on your client PC.
2. Using the vSphere client, select the Inventory view.

3. Locate the required virtual machine in the inventory navigation tree on the left. If not
shown, select View > Show VMs in Inventory

4. Click on the virtual machine.

5. Click on the @ Connect/disconnect the CD/DVD device of the virtual machine icon in
the toolbar.

* If already connected to a source, the details are shown and the option to disconnect.
Select disconnect and then click the @ icon again.

6. From the drop-down, select CD/DVD drive 1 and then select Connect to ISO image on
local disk.

7. Select the ISO file and click Open.

Next steps

* You can now download the ISO to the virtual server using the DVD Primary Server option
in the IP Office Web Manager menus. See Downloading the ISO from the primary DVD on
page 109.

Related links
Connect to an ISO File on the client PCs hard disk on page 102

Mapping the virtual machine's DVD to a local PC ISO file (vSphere

web client)
Procedure

1. Place the 150 file in a folder on your client PC.

2. Using the vSphere web client, select the virtual machine. For example, select vCenter
Management and in the navigation tree on the left select the virtual machine.
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Connect to the client PCs DVD drive

3. Click on the @ icon in the toolbar.

4. From the CD/DVD drive drop-down, select CD/DVD drive 1 and then select Connect to
ISO image on local disk.

5. Select the ISO file and click Open.

6. You can now download the ISO to the virtual server using the DVD Primary Server option
in the IP Office Web Manager menus.
Next steps

* You can now download the ISO to the virtual server using the DVD Primary Server option
in the IP Office Web Manager menus. See Downloading the ISO from the primary DVD on
page 109.
Related links
Connect to an ISO File on the client PCs hard disk on page 102

Connect to the client PCs DVD drive

This method maps the DVD drive of the virtual machine to the DVD drive of the PC running the
VMware client.

On some Windows operating systems, access to the client PC DVD drive requires vSphere to run
with local administrator rights. For details refer to the VMware Knowledge Base.

Related links
Transfer from a virtual machine DVD on page 101
Mapping the virtual machine’s DVD to the local PC drive (vSphere desktop client) on page 103
Mapping the virtual machine's DVD to local PC drive (vSphere web client) on page 104

Mapping the virtual machine’s DVD to the local PC drive (vSphere
desktop client)
Procedure
1. Insert the DVD into the PC's DVD drive.
2. Using the vSphere client, select the Inventory view.

3. Locate the required virtual machine in the inventory navigation tree on the left. If not
shown, select View > Show VMs in Inventory

4. Click on the virtual machine.

5. Click on the ¢» Connect/disconnect the CD/DVD device of the virtual machine icon in
the toolbar.

+ If already connected to a source, the details are shown and the option to disconnect.
Select disconnect and then click the @ icon again.
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Transfer from a virtual machine DVD

6. From the drop-down, select CD/DVD and then select the appropriate drive letter for the PC
drive containing the DVD.

Next steps

* You can now download the ISO to the virtual server using the DVD Primary Server option
in the IP Office Web Manager menus. See Downloading the ISO from the primary DVD on
page 109.

Related links
Connect to the client PCs DVD drive on page 103

Mapping the virtual machine's DVD to local PC drive (vSphere
web client)
Procedure

1. Insert the DVD into the PC's DVD drive.

2. Click Virtual Machines and select a virtual machine from the list and click it.

3. Click the Manage tab, and click the CD/DVD connection icon.

4. Select an available drive to connect to, and browse for the CD/DVD media.

5

. An Access Control dialog box opens. Click Allow to proceed. To change your selection,
click the connection icon, select Disconnect, and select a different option.

6. Click OK.

Next steps

* You can now download the ISO to the virtual server using the DVD Primary Server option
in the IP Office Web Manager menus. See Downloading the ISO from the primary DVD on
page 109.

Related links
Connect to the client PCs DVD drive on page 103

Connect to an ISO File in the virtual server datastore

This method uses an ISO file uploaded to the file datastore used by the virtual machine.

Related links
Transfer from a virtual machine DVD on page 101
Uploading an ISO file to the datastore (vSphere desktop client) on page 105
Uploading an ISO file to the datastore (vSphere web client) on page 105

Mapping the virtual machine DVD to an ISO file in the datastore (vSphere desktop client) on
page 106
Mapping the virtual machine DVD to an ISO file in the datastore (vSphere web client) on page 106
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Connect to an ISO File in the virtual server datastore

Uploading an ISO file to the datastore (vSphere desktop client)

Procedure
1. Place the 150 file in a folder on your client PC.
2. Using the vSphere client, select the Inventory view.

3. Locate the required virtual machine in the inventory navigation tree on the left. If not
shown, select View > Show VMs in Inventory

Click on the virtual machine.
Select the Summary tab on the right.
In the Resources section, right click on the datastore and select Browse Datastore.

Click on the @ and select Upload File.

© N o g &

Browse to the location of the IS0 image and click OK.
9. Once the upload has finished, close the Datastore Browser.

Next steps

* You can now map the virtual machine DVD drive to the 150 file. See Mapping the virtual
machine DVD to an ISQO file in the datastore (vSphere desktop client) on page 106.

Related links
Connect to an ISO File in the virtual server datastore on page 104

Uploading an ISO file to the datastore (vSphere web client)

Procedure

1. Using the vSphere web client, select the virtual machine. For example, select vCenter
Management and in the navigation tree on the left select the virtual machine.

2. In the inventory, click Datastore and on the Objects tab, select the datastore to which you
will upload the file.

3. Click the & icon.
4. Select the folder that you created or select an existing folder, and click the & icon.

5. If the Client Integration Access Control dialog box appears, click Allow to allow the
plug-in to access your operating system and proceed with the file upload.

6. On the local computer, find the 150 file and upload it.

7. Once the upload has finished, refresh the datastore file browser to see the uploaded file in
the list.

Next steps

* You can now map the virtual machine DVD drive to the 150 file. See Mapping the virtual
machine DVD to an ISO file in the datastore (vSphere web client) on page 106.
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Transfer from a virtual machine DVD

Related links
Connect to an ISO File in the virtual server datastore on page 104

Mapping the virtual machine DVD to an ISO file in the datastore
(vSphere desktop client)

Before you begin

» Upload the ISO file. See Uploading an ISO file to the datastore (vSphere desktop client) on
page 105.

Procedure
1. Use the process above to upload the 150 file to the datastore.
2. Using the vSphere client, select the Inventory view.

3. Locate the required virtual machine in the inventory navigation tree on the left. If not
shown, select View > Show VMs in Inventory

4. Click on the virtual machine.

5. Click on @ Connect/disconnect the CD/DVD device of the virtual machine in the
toolbar.

* If already connected to a source, the details are shown and the option to disconnect.
Select disconnect and then click the @ icon again.

6. From the drop-down, select CD/DVD drive 1 and then select Connect to ISO image on
datastore.

7. Select Datastore ISO File and click Browse.
8. Select the ISO file and click OK.

Next steps

* You can now download the ISO to the virtual server using the DVD Primary Server option
in the IP Office Web Manager menus. See Downloading the ISO from the primary DVD on
page 109.

Related links
Connect to an ISO File in the virtual server datastore on page 104

Mapping the virtual machine DVD to an ISO file in the datastore
(vSphere web client)

Before you begin

» Upload the ISO file. See Uploading an ISO file to the datastore (vSphere web client) on
page 105.

Procedure

1. Use the process above to upload the 150 file to the datastore.
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Connect to the host server's DVD drive

2. Right-click the virtual machine and select Edit Settings.

a. To locate a virtual machine, select a datacenter, folder, cluster, resource pool, host, or
VApP.

b. Click the Related Objects tab and click Virtual Machines.
3. Expand CD/DVD, and select Datastore ISO File from the drop-down menu.
4. Browse to select the file and click OK.
5

. Click Edit and select Connected next to the datastore 150 file to connect the device.
6. Click OK.

Next steps

* You can now download the ISO to the virtual server using the DVD Primary Server option
in the IP Office Web Manager menus. See Downloading the ISO from the primary DVD on
page 109.
Related links
Connect to an ISO File in the virtual server datastore on page 104

Connect to the host server's DVD drive

This method uses an 150 file burnt to DVD and then placed into the physical DVD drive of the
VMware server platform. Whilst this method is fast, it requires access to the physical virtual server
platform.

Related links
Transfer from a virtual machine DVD on page 101
Mapping the virtual machine DVD to the host DVD drive (vSphere desktop client) on page 107
Mapping the virtual machine DVD to the host DVD drive (vSphere web client) on page 108

Mapping the virtual machine DVD to the host DVD drive (vSphere
desktop client)

Procedure
1. Insert the DVD into the host server's DVD drive.
2. Using the vSphere client, select the Inventory view.

3. Locate the required virtual machine in the inventory navigation tree on the left. If not
shown, select View > Show VMs in Inventory

4. Click on the virtual machine.
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Transfer from a virtual machine DVD

5. Click on the @ Connect/disconnect the CD/DVD device of the virtual machine icon in
the toolbar.

+ If already connected to a source, the details are shown and the option to disconnect.
Select disconnect and then click the @z icon again.

6. From the drop-down, select CD/DVD and then select Connect to host device.

7. From the drop-down list, select the host device to use. For example, a typical entry for a
CD/DVD drive is /vmfs/devices/cdrom/mpx.vmhbaO:COTOLO.

8. Click OK.
Next steps

* You can now download the ISO to the virtual server using the DVD Primary Server option
in the IP Office Web Manager menus. See Downloading the ISO from the primary DVD on
page 109.

Related links
Connect to the host server's DVD drive on page 107

Mapping the virtual machine DVD to the host DVD drive (vSphere
web client)
Procedure
1. Insert the DVD into the host server's DVD drive.
2. Right-click the virtual machine and select Edit Settings.

a. To locate a virtual machine, select a datacenter, folder, cluster, resource pool, host, or
VApp.

b. Click the Related Objects tab and click Virtual Machines.

3. On the Virtual Hardware tab, expand CD/DVD and from the drop-down menu select Host
Device.

4. If more than one type of CD/DVD media is available on the host, select the media.
5. Click OK.
Next steps

* You can now download the ISO to the virtual server using the DVD Primary Server option
in the IP Office Web Manager menus. See Downloading the ISO from the primary DVD on
page 109.

Related links
Connect to the host server's DVD drive on page 107
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Downloading the ISO from the primary DVD

Downloading the ISO from the primary DVD

About this task

Having connected the virtual server's DVD to an ISO source as above, you can now use IP Office
Web Manager to download that ISO source to the server.

Procedure

Login to IP Office Web Manager.

Click Solution.

Click on the Actions drop-down and select Transfer ISO.

Click Transfer from and select DVD Primary Server.

o 0N =

Click OK. The menu shows the progress of the download.

6. The servers listed in the Solution overview show an 4 icon and Upgrade Available.
Next steps

» Proceed with upgrading from the uploaded file. See Upgrading using the Transferred ISO
file on page 109.

Related links
Transfer from a virtual machine DVD on page 101

Upgrading using the Transferred ISO file
About this task

Having downloaded an IS0 file to the server , IP Office Web Manager indicates those servers

it can upgrade. It does this by showing an 4 icon and Upgrade Available next to the server's
details on the Solution menu.

A Warning:
* Not Supported for Upgrades from Pre-R11.1:

This method of upgrading is not supported for upgrading from pre-R11.1 releases. For
example, from R11.0 to R11.1. The server must be upgraded using the processes in the
Upgrading Linux-Based IP Office Systems to R11.1 manual.

Procedure
1. Login to IP Office Web Manager.
2. Select Solution.

3. Select the checkbox next to each server to upgrade. Upgrades require the primary server
upgraded before any other servers.

4. Click on the Actions drop down and select Upgrade.
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Transfer from a virtual machine DVD

5. The upgrade process typically requires the IP Office server to restart, ending the current
web browser connection. If this occurs, login to IP Office Web Manager again to check on
the status of the upgrade.

Next steps
If necessary, repeat the process to upgrade all the servers.

Related links
Transfer from a virtual machine DVD on page 101
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Part 8: Further Help
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Chapter 18: Additional Help and
Documentation

The following pages provide sources for additional help.

Related links
Additional Manuals and User Guides on page 112
Getting Help on page 112
Finding an Avaya Business Partner on page 113
Additional IP_Office resources on page 113

Training on page 114

Additional Manuals and User Guides

The Avaya Documentation Center website contains user guides and manuals for Avaya products
including IP Office.

« For a listing of the current IP Office manuals and user guides, look at the Avaya IP Office™
Platform Manuals and User Guides document.

* The Avaya IP Office Knowledgebase and Avaya Support websites also provide access to the
IP Office technical manuals and users guides.

- Note that where possible these sites redirect users to the version of the document hosted
by the Avaya Documentation Center.

For other types of documents and other resources, visit the various Avaya websites (see
Additional IP_Office resources on page 113).

Related links
Additional Help and Documentation on page 112

Getting Help

Avaya sells IP Office through accredited business partners. Those business partners provide
direct support to their customers and can escalate issues to Avaya when necessary.
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Finding an Avaya Business Partner

If your IP Office system currently does not have an Avaya business partner providing support and
maintenance for it, you can use the Avaya Partner Locator tool to find a business partner. See
Finding an Avaya Business Partner on page 113.

Related links
Additional Help and Documentation on page 112

Finding an Avaya Business Partner

If your IP Office system currently does not have an Avaya business partner providing support and
maintenance for it, you can use the Avaya Partner Locator tool to find a business partner.

Procedure

1. Using a browser, go to the Avaya Website at https://www.avaya.com

2. Select Partners and then Find a Partner.
3. Enter your location information.
4. For IP Office business partners, using the Filter, select Small/Medium Business.

Related links
Additional Help and Documentation on page 112

Additional IP Office resources

In addition to the documentation website (see Additional Manuals and User Guides on page 112),
there are a range of website that provide information about Avaya products and services including
IP Office.

« Avaya Website (https://www.avaya.com)

This is the official Avaya website. The front page also provides access to individual Avaya
websites for different regions and countries.

» Avaya Sales & Partner Portal (https://sales.avaya.com)

This is the official website for all Avaya business partners. The site requires registration for
a user name and password. Once accessed, you can customize the portal to show specific
products and information type that you want to see.

» Avaya IP Office Knowledgebase (https://ipofficekb.avaya.com)

This site provides access to an online, regularly updated version of IP Office user guides and
technical manual.

« Avaya Support (https://support.avaya.com)
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Additional Help and Documentation

This site provide access to Avaya product software, documentation and other services for
Avaya product installers and maintainers.

- Avaya Support Forums (https://support.avaya.com/forums/index.php)

This site provides forums for discussing product issues.

* International Avaya User Group (https://www.iuag.org)

This is the organization for Avaya customers. It provides discussion groups and forums.

+ Avaya DevConnect (https://www.devconnectprogram.com/)

This site provides details on APIs and SDKs for Avaya products, including IP Office. The site
also provides application notes for third-party non-Avaya products that interoperate with IP
Office using those APIs and SDKs.

» Avaya Learning (https://www.avaya-learning.com/)

This site provides access to training courses and accreditation programs for Avaya products.

Related links
Additional Help and Documentation on page 112

Training

Avaya training and credentials ensure our Business Partners have the capabilities and skills to
successfully sell, implement, and support Avaya solutions and exceed customer expectations. The
following credentials are available:

* Avaya Certified Sales Specialist (APSS)
» Avaya Implementation Professional Specialist (AIPS)
» Avaya Certified Support Specialist (ACSS)
Credential maps are available on the Avaya Learning website.

Related links
Additional Help and Documentation on page 112
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